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Conventions used in this guide

TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging
the product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal
injury, catastrophic loss of data, or extensive damage to the product.
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● Product comparison

● Environmental features

● Accessibility features

● Product views
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Product comparison

Model Features

HP LaserJet Enterprise 500 color
M551n

Part number: CF081A

Performance

● Prints up to 33 pages per minute (ppm) on Letter size paper and 32 ppm on A4
size paper

Paper handling

● 100-sheet multipurpose input tray (Tray 1)

● 500-sheet input tray (Tray 2)

● 250-sheet, face-down output bin

Supported operating systems

● Windows® XP (32-bit and 64-bit)

● Windows Vista® (32-bit and 64-bit)

● Windows 7 (32-bit and 64-bit)

● Windows Server 2003 (32-bit and 64-bit)

● Windows Server 2008 (32-bit and 64-bit) R2 64-bit

● Mac OS X v10.5 and v10.6

Connectivity

● Hi-Speed USB 2.0 port

● HP Jetdirect embedded print server for connecting to a 10/100 Base-TX network

● Wireless accessory available

Memory

● 1 gigabyte (GB) of random access memory (RAM)

Control-panel display

● 4-line color
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Model Features

HP LaserJet Enterprise 500 color
M551dn

Part number: CF082A

This model has the same features as HP LaserJet Enterprise 500 color M551n plus the
following:

Paper handling

● Automatic two-sided printing

Connectivity

● Hardware integration pocket for installing accessories

● USB port for walk-up printing

HP LaserJet Enterprise 500 color
M551xh

Part number: CF083A

This model has the same features as HP LaserJet Enterprise 500 color M551dn plus the
following:

Paper handling

● 500-sheet paper and heavy media tray (Tray 3)

Memory

● HP Encrypted High Performance Hard Disk
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Environmental features

Duplex Save paper by using duplex printing as your default print setting (select models only).

Print multiple pages per sheet Save paper by printing two or more pages of a document side-by-side on one sheet of paper.
Access this feature through the printer driver.

Recycling Reduce waste by using recycled paper.

Recycle print cartridges by using the HP return process.

Energy savings Instant on Fusing technology and HP Auto-On/Auto-Off Technology enable this product to
quickly go into reduced power states when not printing, thus saving energy.

HP Smart Web printing Use HP Smart Web printing to select, store, and organize text and graphics from multiple
Web pages and then edit and print exactly what you see onscreen. It gives you the control
you need for printing meaningful information while minimizing waste.

Download HP Smart Web printing from this Web site: www.hp.com/go/smartweb.

NOTE: HP Smart Web printing is compatible with Windows browsers only.

Job storage Use the job storage features to manage print jobs. By using job storage, you activate printing
while you are at the shared product, eliminating lost print jobs that are then reprinted.
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Accessibility features
The product includes several features that aid you with accessibility issues.

● Online user guide that is compatible with text screen-readers.

● All doors and covers can be opened by using one hand.

● Paper can be loaded in Tray 1 by using one hand.
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Product views

Product front view

1 2 3 4

5

6

7

8

12

9
11

10

1 Output-bin extension

2 Standard output bin

3 Duplex reverse guide (select models only)

4 USB port on the control panel for walk-up printing and hardware integration pocket for installing accessories
(select models only)

5 Control panel

6 Right door (access for clearing jams)

7 Tray 1 (pull the handle to open the tray)

8 Power button (illuminates when turned on)

9 Lower-right door (access for clearing jams) (included with HP LaserJet Enterprise 500 color M551xh)

10 Tray 2

11 Optional Tray 3 (included with HP LaserJet Enterprise 500 color M551xh)

12 Front door (access to print cartridges and toner collection unit)
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Product back view

1 2

3

1 Slot for a cable-type security lock

2 Interface ports

3 Power connection

Interface ports

3
2

1

1 USB port for a third-party device

2 Hi-Speed USB 2.0 printing port

3 RJ-45 network port
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Serial number and model number location

The model number and serial number are listed on an identification label located on the back of the
product. The serial number contains information about the country/region of origin, the product
version, production code, and the production number of the product.
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2 Control panel menus

● Control-panel layout

● Control panel menus

● Sign In menu

● Retrieve Job From USB menu

● Retrieve Job From Device Memory menu

● Supplies menu

● Trays menu

● Administration menu

● Troubleshooting menu

● Device Maintenance menu
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Control-panel layout
The control panel includes a color, graphical and text display, job-control buttons, and three light-
emitting diode (LED) status lights. 

1 2 3 4

5

7

6

89

11

10

1 Control panel display Shows status information, menus, help information, and error messages.

2 Up arrow  button Navigates menus and text, and increases the values of numerical items in
the display.

3 OK button Makes selections, resumes printing after continuable errors, and overrides
a non-HP print cartridge.

4 Ready  light Indicates that the product is ready to begin processing any job.

5 Data  light Indicates that the product is receiving data.

6 Attention  light Indicates that the product has a condition that requires intervention.
Examples include an empty paper tray or an error message on the display.

7 Down arrow  button Navigates menus and text, and decreases the values of numerical items in
the display.

8 Home  button Returns to the top level menu.

9 Back arrow  button Navigates backward in nested menus.

10 Stop  button Halts the current job, presents a choice to resume or cancel the current job,
clears paper from the product, and clears any continuable errors that are
associated with the halted job. If the product is not printing a job, pressing
the Stop  button pauses the product.

11 Help  button Provides detailed information about product messages or menus.
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Control-panel help

The product has a built-in Help system that explains how to use each screen. To open the Help system,
press the Help  button on the control panel.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by pressing the arrow buttons on the control panel.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.
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Control panel menus
To use all of the capabilities of this product, a firmware upgrade might be required. HP recommends
that you periodically go to www.hp.com/go/lj500colorM551_software to see if a new version of
firmware is available.

NOTE: Print a configuration page to determine the version of firmware currently installed in this
product.

Navigate the control-panel menus

● Press the Home  button to access the menus.

● Use the up arrow button  and down arrow button  to highlight a desired menu item.

● Press the OK button to select the menu item.

Sign In menu

Table 2-1  Sign In menu

First level Second level Values

User Access Code Access Code  

Administrator Access Code Access Code  

Service Access Code Access Code  

Retrieve Job From USB menu
Use the Retrieve Job From USB menu to view listings of jobs stored on an external USB memory
device.

NOTE: You must enable this feature by using the control-panel menus or the HP Embedded Web
Server before it can be used.

To enable this feature by using the control-panel menus, access the Administration menu, General
Settings sub menu, Retrieve From USB Settings sub menu, and then select Enable. To enable
this feature by using the HP Embedded Web Server, access the Print tab.

Table 2-2  Retrieve Job From USB menu

First level Second level Values

Retrieve Job From USB  OK

Cancel

 Select a File or Folder Select from the provided list.
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Retrieve Job From Device Memory menu
Use the Retrieve Job From Device Memory menu to view listings of jobs stored on the internal
product memory.

Table 2-3  Retrieve Job From Device Memory menu

First level Second level Third level Fourth level Fifth level Values

Retrieve Job From
Device Memory

NOTE: Select from a
list of folders.

All Jobs (With PIN)

NOTE: Individual job
names also appear.

Print Enter PIN to
Print

 

 Copies Range: 1 – 9999

Default = 1

Print and Delete Enter PIN to
Print

 

 Copies Range: 1 – 9999

Default = 1

Delete Enter PIN to
Print

 

All Jobs (No PIN)

NOTE: Individual job
names also appear.

Print Copies Range: 1 – 9999

Default = 1

Print and Delete Copies Range: 1 – 9999

Default = 1

Delete Delete All Jobs Yes

No
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Supplies menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-4  Supplies menu

First level Second level Third level Fourth level Values  

Manage Supplies Print Supplies
Status

    

 Supply Settings Black Cartridge Very Low
Settings

 Stop

Prompt to
continue*

Continue

   Low Threshold
Settings

 1-100%

  Color Cartridges Very Low
Settings

 Stop

Prompt to
continue*

Continue

   Low Threshold
Settings

Cyan Cartridge

Magenta
Cartridge

Yellow Cartridge

1-100%

  Toner Collection
Unit

Very Low
Settings

 Stop*

Prompt to
continue

Continue

  Fuser Kit Very Low
Settings

 Stop

Prompt to
continue*

Continue

   Low Threshold
Settings

 1-100%

  Color/Black Mix   Auto*

Mostly Color
Pages

Mostly Black
Pages

 Supply Messages Low Message   On*

Off
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Table 2-4  Supplies menu (continued)

First level Second level Third level Fourth level Values  

  Level Gauge   On*

Off

 Reset Supplies New Fuser Kit   No*

Yes

Black Cartridge     The status is
displayed.

Cyan Cartridge     The status is
displayed.

Magenta
Cartridge

    The status is
displayed.

Yellow Cartridge     The status is
displayed.

Toner Collection
Unit

    The status is
displayed.

Fuser Kit     The status is
displayed.
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Trays menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-5  Trays menu

First level Second level Values

Manage Trays Use Requested Tray Exclusively*

First

 Manually Feed Prompt Always*

Unless loaded

 Size/Type Prompt Display*

Do not display

 Use Another Tray Enabled*

Disabled

 Alternative Letterhead Mode Disabled*

Enabled

 Duplex Blank Pages Auto*

Yes

 Image Rotation Standard*

Alternate

 Override A4/Letter Yes*

No

Tray 1 Size  Select from a provided list.

Tray 1 Type  Select from a provided list.

Tray 2 Size  Select from a provided list.

Tray 2 Type  Select from a provided list.

Tray 3 Size  Select from a provided list.

Tray 3 Type  Select from a provided list.
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Administration menu

Reports menu

Table 2-6  Reports menu

First level Second level

Configuration/Status Pages Print

 Administration Menu Map

 Configuration Page

 Supplies Status Page

 Usage Page

 File Directory Page

 Current Settings Page

 Color Usage Job Log

Other Pages Print

 Demonstration Page

 RGB Samples

 CMYK Samples

 PCL Font List

 PS Font List

General Settings menu

In the following table, asterisks (*) indicate the factory default setting.

Table 2-7  General Settings menu

First level Second level Third level Fourth level Values

Date/Time Settings Date/Time Format Date Format  DD/MMM/YYYY

MMM/DD/YYYY*

YYYY/MMM/DD

  Time Format  12 hour (AM/PM)*

24 hours

 Date/Time Date Month

Day

Year

Set values from the lists.
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Table 2-7  General Settings menu (continued)

First level Second level Third level Fourth level Values

  Time Hour

Minute

AM/PM

Set values from the lists.

  Time Zone Month

Day

Year

Set values from the lists.

  Adjust for Daylight
Savings

 On

Off*

Energy Settings Sleep Timer Settings Sleep/Auto Off Timer  Enable*

Disable

  Sleep/Auto Off After  The default value is 45
minutes.

Enter a value between 1
and 120 minutes.

  Wake/Auto On
Events

 All Events*

Network port

Power button only

 Optimum Speed/
Energy Usage

  Faster First Page*

Save Energy

Save More Energy

Save Most Energy

Print Quality Adjust Color Highlights Cyan Density

Magenta Density

Yellow Density

Black Density

-5 to 5

Default = 0

  Midtones Cyan Density

Magenta Density

Yellow Density

Black Density

-5 to 5

Default = 0
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Table 2-7  General Settings menu (continued)

First level Second level Third level Fourth level Values

  Shadows Cyan Density

Magenta Density

Yellow Density

Black Density

-5 to 5

Default = 0

  Restore Color Values   

 Image Registration Adjust Tray <X> Print Test Page  

   X1 Shift

Y1 Shift

X2 Shift

Y2 Shift

-5.00 mm to 5.00 mm

Default = 0

 Auto Sense Behavior Tray 1 Sensing  Fuser Kit

Expanded sensing

Transparency only

 Adjust Paper Types Select from a list of paper
types that the product
supports. The available
options are the same for
each paper type.

Print Mode Select from a list of print
modes.

Default = Auto Sense
Behavior

   Resistance Mode Normal*

Up

Down

   Humidity Mode Normal*

High

   Pre-Rotation Mode Off*

On

   Fuser Temp Mode Normal*

Up

Down

   Paper Curl Mode Normal*

Reduced

 Optimize Normal Paper  Standard*

Smooth
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Table 2-7  General Settings menu (continued)

First level Second level Third level Fourth level Values

  Heavy Paper  Standard*

Smooth

  Envelope Control  Normal*

Alternate 1

Alternate 2

  Environment  Normal*

Low Temp

  Line Voltage  Normal*

Low Voltage

  Tray 1  Normal*

Alternate

  Background  Normal*

Alternate 1

Alternate 2

Alternate 3

  Uniformity Control  Normal*

Alternate 1

Alternate 2

Alternate 3

  Tracking Control  On*

Off

  Registration  Normal*

Alternate

  Transfer Control  Normal*

Alternate 1

Alternate 2

Alternate 3

  Fuser Temp  Normal*

Alternate

  Restore Optimize   
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Table 2-7  General Settings menu (continued)

First level Second level Third level Fourth level Values

 Edge Control   Off

Light

Normal*

Maximum

Jam Recovery    Auto*

Off

On

Auto Recovery    Enable

Disable*

Manage Stored Jobs Quick Copy Job
Storage Limit

  1-300

Default = 32

 Quick Copy Job Held
Timeout

  Off*

1 Hour

4 Hours

1 Day

1 Week

 Default Folder Name    

 Sort Stored Jobs By   Job Name*

Date

Restore Factory
Settings

Reset   All

General

Print

General Security

Calibration

Restrict Color    Enable color

Disable color

Color if allowed*

ENWW Administration menu 21



Retrieve From USB Settings menu

Table 2-8  Retrieve From USB Settings menu

First level Second level Values

Enable Retrieve from USB  Enable

Disable*

General Print Settings menu

In the following table, asterisks (*) indicate the factory default setting.

Table 2-9  General Print Settings menu

First level Second level Values

Manual Feed  Enabled

Disabled*

Courier Font  Regular*

Dark

Wide A4  Enabled

Disabled*

Print PS Errors  Enabled

Disabled*

Print PDF Errors  Enabled

Disabled*

Personality  Auto*

PCL

PS

PDF

PCL Form Length Range: 5 – 128

Default = 60

 Orientation Portrait*

Landscape

 Font Source Internal*

Soft

USB <X>
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Table 2-9  General Print Settings menu (continued)

First level Second level Values

 Font Number Range: 0 – 999

Default = 0

 Font Pitch Range: 0.44 – 99.99

Default = 10

 Font Point Size Range: 4.00 – 999.75

Default = 12.00

 Symbol Set Select from a list of symbol sets.

 Append CR to LF No*

Yes

 Suppress Blank Pages No*

Yes

 Media Source Mapping Standard*

Classic

Default Print Options menu

In the following table, asterisks (*) indicate the factory default setting.

Table 2-10  Default Print Options menu

First level Second level   Values

Number of Copies    Range: 1 – X

Default = 1

Default Paper Size    Select from a list of sizes
that the product supports.

Default Custom Paper
Size

Unit of Measure Inches X Dimension Range: 2.99 – 12.28

Default = 12.28

   Y Dimension Range: 5.00 – 18.50

Default = 18.5

  MM X Dimension Range: 76 – 312

Default = 312

   Y Dimension Range: 127 – 470

Default = 470

ENWW Administration menu 23



Table 2-10  Default Print Options menu (continued)

First level Second level   Values

Sides    1-sided*

2-sided

2-Sided Format    Book-style*

Flip-style

Edge to Edge    Enabled

Disabled*
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Display Settings menu

In the following table, asterisks (*) indicate the factory default setting.

Table 2-11  Display Settings menu

First level Second level Values

Display Brightness  Range: -10 to 10

Default = 0

Language  Select from a list of languages that the
product supports.

Show IP Address  Display*

Hide

Inactivity Timeout  Range: 10 – 300 seconds

Default = 60

Clearable Warnings  On

Job*

Continuable Events  Auto continue (10 seconds)*

Press OK to continue
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Manage Supplies menu

In the following table, asterisks (*) indicate the factory default setting.

Table 2-12  Manage Supplies menu

First level Second level Third level Fourth level Values

Print Supplies Status     

Supply Settings Black Cartridge Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold
Settings

 1-100%

 Color Cartridges Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold
Settings

Cyan Cartridge

Magenta Cartridge

Yellow Cartridge

1-100%

 Toner Collection Unit Very Low Settings  Stop*

Prompt to continue

Continue

 Fuser Kit Very Low Settings  Stop

Prompt to continue*

Continue

  Low Threshold
Settings

 1-100%

 Color/Black Mix   Auto*

Mostly Color Pages

Mostly Black Pages

Supply Messages Low Message   On*

Off

 Level Gauge   On*

Off

Reset Supplies New Fuser Kit   No*

Yes
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Manage Trays menu

In the following table, asterisks (*) indicate the factory default setting.

Table 2-13  Manage Trays menu

First level Values

Use Requested Tray Exclusively*

First

Manually Feed Prompt Always*

Unless loaded

Size/Type Prompt Display*

Do not display

Use Another Tray Enabled*

Disabled

Alternative Letterhead Mode Disabled*

Enabled

Blank Pages Auto*

Yes

Override A4/Letter Yes*

No
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Network Settings menu

In the following table, asterisks (*) indicate the factory default setting.

Table 2-14  Network Settings menu

First level Values

I/O Timeout Range: 5 – 300 sec

Default = 15

Jetdirect Menu See the table that follows for details.

Table 2-15  Jetdirect Menu

First level Second level Third level Fourth level Fifth level Values

Information Print Sec Report    Yes

No*

TCP/IP Enable    On*

Off

 Host Name    Use the arrow
buttons to edit the
host name.

NPIXXXXXX*

 IPv4 Settings Config Method   Bootp*

DHCP

Auto IP

Manual

  Manual Settings

NOTE: This menu
is available only if
you select the
Manual option
under the Config
Method menu.

IP Address  Enter the address

   Subnet Mask  Enter the address

   Default Gateway  Enter the address

  Default IP   Auto IP*

Legacy

  DHCP Release   Yes

No*
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Table 2-15  Jetdirect Menu (continued)

First level Second level Third level Fourth level Fifth level Values

  DHCP Renew   Yes

No*

  Primary DNS   Range: 0 – 255

Default =
xxx.xxx.xx.xx

  Secondary DNS   Range: 0 – 255

Default = 0.0.0.0

 IPv6 Settings Enable   On*

Off

  Address Manual Settings Enable On

Off*

    Address Select from a
provided list.

  DHCPV6 Policy   Router Specified

Router
Unavailable*

Always

  Primary DNS   Select from a
provided list.

  Secondary DNS   Select from a
provided list.

 Proxy Server    Select from a
provided list.

 Proxy Port    Default = 00080

 Idle Timeout    Default = 0270

General Security Secure Web    HTTPS Required*

HTTPS Optional

 IPSEC    Keep

Disable*

 802.1x    Reset

Keep*

 Reset Security    Yes

No*
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Table 2-15  Jetdirect Menu (continued)

First level Second level Third level Fourth level Fifth level Values

Diagnostics Embedded Tests LAN HW Test   Yes

No*

  HTTP Test   Yes

No*

  SNMP Test   Yes

No*

  Data Path Test   Yes

No*

  Select All Tests   Yes

No*

  Execution Time   Range: 1 – 60 hours

Default = 1

  Execute   Yes

No*

 Ping Test Dest Type   IPv4

IPv6

  Dest IPv4   Range: 0 – 255

Default =
127.0.0.1

  Dest IPv6   Select from a
provided list.

Default = : : 1

  Packet Size   Default = 64

  Timeout   Default = 001

  Count   Default = 004

  Print Results   Yes

No*

  Execute   Yes

No*

 Ping Results Packets Sent   Default = 00000

  Packets Received   Default = 00000

  Percent Lost   Default = 000
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Table 2-15  Jetdirect Menu (continued)

First level Second level Third level Fourth level Fifth level Values

  RTT Min   Default = 0000

  RTT Max   Default = 0000

  RTT Average   Default = 0000

  Ping In Progress   Yes

No*

  Refresh   Yes

No*

Link Speed     Auto*

10T Half

10T Full

100TX Half

100TX Full

100TX Auto

1000T Full
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Troubleshooting menu
In the following table, asterisks (*) indicate the factory default setting.

Table 2-16  Troubleshooting menu

First level Second level Third level Fourth level Values

Exit Troubleshooting

NOTE: This item only
displays if you are
backing out of the
Troubleshooting menu.

NOTE: The product
shuts down and restarts
when this menu item is
selected.

    

Print Event Log     

View Event Log     

Print Paper Path
Page

    

Print Quality Pages Print PQ
Troubleshooting
Pages

   

 Print Diagnostic Page    

 Color Band Test Print Test Page   

  Copies  Range: 1 – 30

Default = 1

Diagnostic Tests Disable Cartridge
Check

   

 Paper Path Sensors   Start Test

 Paper Path Test Print Test Page  Print

  Source Tray  Select from a list of the
available trays.

  Test Duplex Path  Off*

On

  Number of Copies  Range: 1 – 500

Default = 1

 Manual Sensor Test   Select from a list of the
product sensors.

 Manual Tray/Bin
Sensor Test

  Select from a list of the
product sensors.
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Table 2-16  Troubleshooting menu (continued)

First level Second level Third level Fourth level Values

 Component Test   Select from a list of
available components.

  Repeat  Off*

On

 Print/Stop Test    

Retrieve Diagnostic
Data

Export to USB    

 Diagnostic Files   Device Data File

Debug Information
File*

 Include Crash Dumps   Off

On*

 Cleanup Debug Info   Off

On*

Generate Debug Data     
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Device Maintenance menu

Backup/Restore menu

CAUTION: Data backup and restoration is the responsibility of the customer/administrator of the
product. Service personnel should not back up or restore customer data under any circumstances.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-17  Backup/Restore menu

First level Second level Third level Values

Backup Data Scheduled Backups Enable Scheduling Disabled*

Enabled

  Backup Time Default = current time

  Days Between Backups Default = 1

 Backup Now   

 Export Last Backup   

Restore Data   Insert a USB drive that contains
the backup file.

Calibrate/Cleaning menu

In the following table, asterisks (*) indicate the factory default setting.

Table 2-18  Calibrate/Cleaning menu

First level Second level Values

Cleaning Settings Auto Cleaning Off*

On

 Cleaning Interval Select from a list of cleaning intervals.

 Auto Cleaning Size Letter*

A4

Print Cleaning Page   

Clean Laser Glass   

Quick Calibration   

Full Calibration   

Delay Calibration at Wake/Power
On

 Yes*

No
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USB Firmware Upgrade menu

To display: At the product control panel, select the Device Maintenance menu, and then select the
USB Firmware Upgrade menu.

Insert a USB storage device with a firmware upgrade bundle into the USB port, and follow the on-
screen instructions.

Service menu

The Service menu is locked and requires a personal identification number (PIN) for access. This menu
is intended for use by authorized service personnel.
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3 Software for Windows

● Supported operating systems and printer drivers for Windows

● Select the correct printer driver for Windows

● Change print job settings for Windows

● Remove the printer driver from Windows

● Supported utilities for Windows

● Software for other operating systems
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Supported operating systems and printer drivers for
Windows

The product supports the following Windows operating systems:

Operating systems Supported by product Supported by installer CD in box

Windows® XP Service Pack 2 or greater
(32-bit)

Windows® XP (64-bit)1  

Windows Vista® (32-bit and 64-bit)

Windows 7 (32-bit and 64-bit)

Windows Server 2003 (32-bit)

Windows Server 2003 (64-bit)  

Windows Server 2008 (32-bit and 64-
bit) R2 64-bit

1 For the 64-bit versions of Windows XP, you can download the printer driver from the Internet and install it by using the
Windows Add Printer Wizard.

The product supports the following Windows printer drivers:

● HP PCL 6 (this is the default printer driver, installed from the in-box software CD)

● HP PCL 6 Universal Print Driver (HP UPD PCL 6)

● HP postscript emulation Universal Print Driver (HP UPD PS)

● HP PCL 5 Universal Print Driver (HP UPD PCL 5)

The printer drivers include online Help that has instructions for common printing tasks and also
describes the buttons, checkboxes, and drop-down lists that are in the printer driver.

NOTE: For more information about the UPD, see www.hp.com/go/upd.

Select the correct printer driver for Windows
Printer drivers provide access to the product features and allow the computer to communicate with the
product (using a printer language). The following printer drivers are available at www.hp.com/go/
lj500colorM551_software.
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HP PCL 6 driver ● Provided as the default driver on the in-box software CD. This driver is
automatically installed unless you download a different one from the Internet.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PCL 6 driver ● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows GDI for the best speed in Windows
environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 driver ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX®, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

ENWW Select the correct printer driver for Windows 39



HP Universal Print Driver (UPD)

The HP Universal Print Driver (UPD) for Windows is a single driver that gives you instant access to
virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on
proven HP print driver technology and has been tested thoroughly and used with many software
programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and then
customizes the user interface to show the product’s unique, available features. It automatically enables
features that are available for the product, such as two-sided printing and stapling, so you do not need
to enable them manually.

For more information, go to www.hp.com/go/upd.

UPD installation modes

Traditional mode ● Use this mode if you are installing the driver from a CD for a single computer.

● When installed from the CD that comes with the product, UPD operates like
traditional printer drivers. It operates with a specific product.

● If you use this mode, you must install UPD separately for each computer and
for each product.

Dynamic mode ● To use this mode, download UPD from the Internet. See www.hp.com/go/
upd.

● Dynamic mode allows you to use a single driver installation, so you can
discover and print to HP products in any location.

● Use this mode if you are installing UPD for a workgroup.
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Change print job settings for Windows

Priority print settings for Windows

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here override settings
changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and usually do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box
to open the printer driver. Settings changed in the Printer Properties dialog box usually do not
override settings anywhere else in the printing software. You can change most of the print settings
here.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is
closed

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.
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Change the product configuration settings

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.

4. To automatically configure product settings, expand the Installable Options list, click the
Automatic Configuration setting, and select the Update Now option.
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Remove the printer driver from Windows
NOTE: You can also remove the printer driver by running the printer driver install from the CD and
choosing the uninstall option.

NOTE: These steps can vary depending on your personal settings.

Windows XP

1. Click Start, Control Panel, and then Add or Remove Programs.

2. Find and select the product from the list.

3. Click the Change/Remove button to remove the software.

Windows Vista

1. Click Start, Control Panel, and then under the Programs heading, click Uninstall a
program.

2. Find and select the product from the list.

3. Select the Uninstall/Change option.

Windows 7

1. Click Start, Control Panel, and then under the Programs heading, click Uninstall a
program.

2. Find and select the product from the list.

3. Select the Uninstall option.
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Supported utilities for Windows

HP Web Jetadmin

HP Web Jetadmin is a simple print and imaging peripheral management software tool that helps
optimize product use, control color costs, secure products, and streamline supplies management by
enabling remote configuration, proactive monitoring, security troubleshooting, and reporting of printing
and imaging products.

To download a current version of HP Web Jetadmin and for the latest list of supported host systems,
visit www.hp.com/go/webjetadmin.

When installed on a host server, a Windows client can gain access to HP Web Jetadmin by using a
supported Web browser (such as Microsoft® Internet Explorer) by navigating to the HP Web Jetadmin
host.

HP Embedded Web Server

The product is equipped with the HP Embedded Web Server, which provides access to information
about product and network activities. This information appears in a Web browser, such as Microsoft
Internet Explorer, Netscape Navigator, Apple Safari, or Mozilla Firefox.

The HP Embedded Web Server resides on the product. It is not loaded on a network server.

The HP Embedded Web Server provides an interface to the product that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
HP Embedded Web Server, type the IP address for the product in the address line of the browser. (To
find the IP address, print a configuration page. For more information about printing a configuration
page, see Print information pages on page 168).

For a complete explanation of the features and functionality of the HP Embedded Web Server, see Use
the HP Embedded Web Server on page 170.

HP ePrint

With HP ePrint , you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile
device. HP ePrint works with any email-capable device. If you can e-mail, you can print to an HP ePrint-
enabled product. For more details, go to www.hpeprintcenter.com.

NOTE: The product must be connected to a network and have Internet access to use HP ePrint.

HP ePrint is disabled as a default setting in the product. Use this procedure to enable it.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded
Web Server.

2. Click the Web Services tab.

3. Select the option to enable Web Services.
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Software for other operating systems

OS Software

UNIX For HP-UX and Solaris networks, go to www.hp.com/go/jetdirectunix_software to install
model scripts using the HP Jetdirect printer installer (HPPI) for UNIX.

For the latest model scripts, go to www.hp.com/go/unixmodelscripts.

Linux For information, go to www.hplip.net.

SAP For drivers, go to www.hp.com/go/sap/drivers
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4 Use the product with Mac

● Software for Mac

● Basic print tasks with Mac

● Solve problems with a Mac
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Software for Mac

Supported operating systems and printer drivers for Mac

The product supports the following Mac operating systems:

● Mac OS X v10.5 and v10.6

NOTE: For Mac OS X v10.5, PPC and Intel® Core™ Processor Macs are supported. For Mac OS X
v10.6, Intel Core Processor Macs are supported.

The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, Printer Dialog
Extensions (PDEs), and the HP Utility for use with Mac OS X computers. The HP printer PPD and PDE
files, in combination with the built-in Apple PostScript printer drivers, provide full printing functionality
and access to specific HP printer features.

Install software for Mac operating systems

Install software for Mac computers connected directly to the product

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a
cable that is no longer than 2 m (6.5 ft).

1. Connect the USB cable to the product and the computer.

2. Install the software from the CD. Click the product icon, and follow the onscreen instructions.

If you did not add a printer during the CD install process, continue with the next step.

3. At the computer, open the Apple menu , click the System Preferences menu, and then click
the Print & Fax icon.

4. Click the plus (+) symbol in the lower left corner of the Printer Names column, select the product
from the Add Printer window, and then make sure that the product driver is listed in the Print
Using area.
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5. Click Add to create the printer queue.

NOTE: For Mac OS X v10.5 and v10.6, the installation procedure should automatically
configure the installed options.

6. Print a page from any program to make sure that the software is correctly installed.

NOTE: If the installation failed, reinstall the software.

Install software for Mac computers on a wired network

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. At the product control panel, press the Home  button.

4. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

● Configuration Page
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5. Find the IP address on the Embedded Jetdirect page.

Jetdirect Page HP Color LaserJet
Page 1

6. IPv4: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure
the IP address. Otherwise, the network configuration was successful.

IPv6: If the IP address begins with "fe80:", the product should be able to print. If not, you must
manually configure the IP address.

Install the software

1. Install the software from the CD. Click the product icon, and follow the onscreen instructions.

If you did not add a printer during the CD install process, continue with the next step.

2. At the computer, open the Apple menu , click the System Preferences menu, and then click
the Print & Fax icon.

3. Click the plus (+) symbol in the lower left corner of the Printer Names column.

By default, Mac OS X uses the Bonjour method to find the driver and add the product to the
printer pop-up menu. This method is best in most situations. If Mac OS X cannot find the HP printer
driver, an error message displays. Reinstall the software.

If you are connecting the product to a large network, you might need to use IP printing to connect
rather than Bonjour. Follow these steps:

a. From the Add Printer window, click the IP Printer button.

b. From the Protocol drop-down list, select the HP Jetdirect-Socket option. Enter the IP
address or host name for the product. From the Print Using drop-down list, select the
product model if one is not already selected.

4. Print a page from any program to make sure that the software is correctly installed.
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Remove the printer driver from Mac operating systems

You must have administrator rights to remove the software.

1. Open System Preferences.

2. Select Print & Fax.

3. Highlight the product.

4. Click the minus (-) symbol.

5. Delete the print queue, if necessary.
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Change print job settings for Mac

Priority print settings for Mac

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here might override
settings changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and do not override changes made in the Page Setup dialog box.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is closed

1. On the File menu, click the Print button.

2. Change the settings that you want on the various menus.

Change the default settings for all print jobs

1. On the File menu, click the Print button.

2. Change the settings that you want on the various menus.

3. On the Presets menu, click the Save As... option and type a name for the preset.

These settings are saved in the Presets menu. To use the new settings, you must select the saved preset
option every time you open a program and print.

Change the product configuration settings

1. From the Apple menu , click the System Preferences menu and then click the Print & Fax
icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.

52 Chapter 4   Use the product with Mac ENWW



Software for Mac computers

HP Printer Utility for Mac

Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected to a
TCP/IP-based network.

Open the HP Printer Utility

▲ From the dock, click HP Utility.

-or-

From Applications, open the Hewlett-Packard folder, and then click HP Utility.

HP Printer Utility features

The HP Utility consists of pages that you open by clicking in the Configuration Settings list. The
following table describes the tasks that you can perform from these pages. At the top of any page, click
the HP Support link to access technical assistance, online supplies ordering, online registration, and
recycling and return information.

Menu Item Description

Information And
Support

Supplies Status Shows the product supplies status and provides links for online
supplies-ordering.

 Device Information Shows information about the currently selected product.

 File Upload Transfers files from the computer to the product.

 Upload Fonts Transfers font files from the computer to the product.

 Update Firmware Transfers a firmware update file to the product.

 Commands Sends special characters or print commands to the product after the
print job.

Printer Settings Trays Configuration Changes the default tray settings.

 Output Devices Manages settings for the optional output accessories

 Duplex Mode Turns on the automatic two-sided printing mode.

 Stored Jobs Manages print jobs that are stored on the product hard disk.

 E-mail Alerts Configures the product to send e-mail notices for certain events.

 Network Settings Configures the network settings, such as the IPv4 and IPv6 settings.

 Supplies
Management

Configures how the product should behave when supplies are
nearing the end of their estimated life.

 Protect Direct Ports Disables printing over USB or parallel ports.

 Additional Settings Provides access to the HP Embedded Web Server.
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Supported utilities for Mac

HP Embedded Web Server

The product is equipped with the HP Embedded Web server, which provides access to information
about product and network activities. Access the HP Embedded Web Server from the HP Utility. Open
the Printer Settings menu, and then select the Additional Settings option.

You can also access the HP Embedded Web Server from the Safari Web browser:

1. Select the page icon in the left side of the Safari toolbar.

2. Click the Bonjour logo.

3. In the list of printers, double-click this product. The HP Embedded Web Server opens.

HP ePrint

With HP ePrint , you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile
device. HP ePrint works with any email-capable device. If you can e-mail, you can print to an HP ePrint-
enabled product. For more details, go to www.hpeprintcenter.com.

NOTE: The product must be connected to a network and have Internet access to use HP ePrint.

HP ePrint is disabled as a default setting in the product. Use this procedure to enable it.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded
Web Server.

2. Click the Web Services tab.

3. Select the option to enable Web Services.

AirPrint

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to
the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in
the following applications:

● Mail

● Photos

● Safari

● Select third-party applications

To use AirPrint, the product must be connected to a network. For more information about using AirPrint
and about which HP products are compatible with AirPrint, go to www.hp.com/go/airprint.

NOTE: You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/go/
lj500colorM551_firmware.
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Basic print tasks with Mac

Cancel a print job with a Mac

If the print job is currently printing, cancel it by pressing the Cancel button on the product control panel.

NOTE: Pressing the Cancel button clears the job that the product is currently processing. If more than
one process is running (for example, the product is printing a document while receiving a fax), pressing
the Cancel button clears the process that currently appears on the product control panel.

You can also cancel a print job from a software program or a print queue.

To stop the print job immediately, remove the remaining print media from the product. After printing
stops, use one of the following options:

● Product control panel: To cancel the print job, press and release the Cancel button on the
product control panel.

● Software program: Typically, a dialog box appears briefly on the computer screen, allowing
you to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.

Change the paper size and type with Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Resize documents or print on a custom paper size with Mac

Mac OS X 10.5 and 10.6

Use one of these methods.

1. On the File menu, click the Print option.

2. Click the Page Setup button.

3. Select the product, and then select the correct settings for the Paper Size and
Orientation options.

1. On the File menu, click the Print option.

2. Open the Paper Handling menu.

3. In the Destination Paper Size area, click the Scale to fit paper size
box, and then select the size from the drop-down list.
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Create and use printing presets with Mac

Use printing presets to save the current printer driver settings for reuse.

Create a printing preset

1. On the File menu, click the Print option.

2. Select the driver.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.

Use printing presets

1. On the File menu, click the Print option.

2. Select the driver.

3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.

Print a cover page with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the
Before Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type
menu.

Use watermarks with Mac

1. On the File menu, click the Print option.

2. Open the Watermarks menu.

3. From the Mode menu, select the type of watermark to use. Select the Watermark option to print
a semi-transparent message. Select the Overlay option to print a message that is not transparent.

4. From the Pages menu, select whether to print the watermark on all pages or on the first page
only.
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5. From the Text menu, select one of the standard messages, or select the Custom option and type
a new message in the box.

6. Select options for the remaining settings.

Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Layout menu.

4. From the Pages per Sheet menu, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing) with Mac

Use automatic duplex printing

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Layout menu.

4. From the Two-Sided menu, select a binding option.

Print on both sides manually

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Finishing menu, and click the Manual Duplex tab or open the Manual Duplex
menu.
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4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button. Follow the instructions in the pop-up window that appears on the computer
screen before replacing the output stack in Tray 1 for printing the second half.

6. Go to the product, and remove any blank paper that is in Tray 1.

7. Insert the printed stack face-up with the bottom edge feeding into the printer first in Tray 1. You
must print the second side from Tray 1.

8. If prompted, press the appropriate control-panel button to continue.

Store jobs with Mac

You can store jobs on the product so you can print them at any time. You can share stored jobs with
other users, or you can make them private.

1. On the File menu, click the Print option.

2. Open the Job Storage menu.

3. In the Job Storage Mode drop-down list, select the type of stored job.

● Proof and Hold: This feature provides a quick way to print and proof one copy of a job
and then print more copies.

● Personal Job: When you send a job to the product, the job does not print until you request
it at the product control panel. If you assign a personal identification number (PIN) to the job,
you must provide the required PIN at the control panel.

● Quick Copy: If the optional hard disk is installed on the product, you can print the
requested number of copies of a job and then store a copy of the job on the optional hard
disk. Storing the job allows you to print additional copies of the job later.

● Stored Job: If the optional hard disk is installed on the product, you can store a job such as
a personnel form, time sheet, or calendar on the product and allow other users to print the
job at any time. Stored jobs also can be protected by a PIN.

4. To use a custom user name or job name, click the Custom button, and then enter the user name
or the job name.

Select which option to use if another stored job already has that name.

Use Job Name + (1 - 99) Append a unique number to the end of the job name.

Replace Existing File Overwrite the existing stored job with the new one.

5. If you selected the Stored Job or Personal Job option in step 3, you can protect the job with a
PIN. Type a 4-digit number in the Use PIN to Print field. When other people attempt to print
this job, the product prompts them to enter this PIN number.
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Set the color options with Mac

Use the Color Options menu or the Color/Quality Options menu to control how colors are
interpreted and printed from software programs.

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Color Options menu or the Color/Quality Options menu.

4. Open the Advanced menu, or select the appropriate tab.

5. Adjust the individual settings for text, graphics, and photographs.

Use the Services menu with Mac

If the product is connected to a network, use the Services menu to obtain product and supply-status
information.

1. On the File menu, click the Print option.

2. Open the Services menu.

3. To open the embedded Web server and perform a maintenance task, do the following:

a. Select the Device Maintenance tab.

b. Select a task from the drop-down list.

c. Click the Launch button.

4. To go to various support Web sites for this product, do the following:

a. Select the Services on the Web tab.

b. Select an option from the menu.

c. Click the Go! button.

Solve problems with a Mac
See Solve product software problems with Mac on page 218.
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5 Connect the product with Windows

● Printer sharing disclaimer

● Connect with USB

● Connect to a network with Windows
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Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Connect with USB
This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a
cable that is no longer than 2 m (6.5 ft).

CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

CD installation

1. Quit all open programs on the computer.

2. Install the software from the CD, and follow the onscreen instructions.

3. When prompted, select the Connected directly to the computer option, and then click the
Install button.

4. When the software prompts you, connect the USB cable to the product and the computer.

5. At the end of the installation, click the Finish button, or click the More Options button to install
more software.

6. On the More Options screen, you can install more software, or click the Exit button.

7. Print a page from any program to make sure that the software is correctly installed.

NOTE: If the installation failed, reinstall the software.
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Connect to a network with Windows
You can configure network parameters from the control panel, the HP Embedded Web Server, or for
most networks, from the HP Web Jetadmin software.

NOTE: HP Web Jetadmin software is not supported on Mac OS X operating systems.

For a complete list of supported networks and for instructions on configuring network parameters from
software, see the HP Jetdirect Embedded Print Server Administrator’s Guide. The guide comes with
products in which an HP Jetdirect embedded print server is installed.

Supported network protocols

Table 5-1  Supported network protocols

Network type Supported protocols

TCP/IP IPv4 and IPv6 networks ● Bonjour (mDNS)

● Simple Network Management Protocol (SNMP) v1, v2, and v3

● Hyper Text Transfer Protocol (HTTP)

● Secure HTTP (HTTPS)

● File Transfer Protocol (FTP)

● Port 9100

● Line printer daemon (LPD)

● Intenet Printing Protocol (IPP)

● Secure IPP

● Web Services Dynamic Discovery (WS Discovery)

● IPsec/Firewall

TCP/IP IPv4 networks only ● Auto IP

● Service Location Protocol (SLP)

● Trivial File Transfer Protocol (TFTP)

● Telnet

● Internet Group Management Protocol (IGMP) v2

● Bootstrap Protocol (BOOTP)/DHCP

● Windows Internet Name Service (WINS)

● IP Direct Mode

● WS Print
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Table 5-1  Supported network protocols (continued)

Network type Supported protocols

TCP/IP IPv6 networks only ● Dynamic Host Configuration Protocol (DHCP) v6

● Multicast Listener Discovery Protocol (MLD) v1

● Internet Control Message Protocol (ICMP) v6

Other supported network protocols ● AppleTalk

● iPrint

Table 5-2  Advanced Security features for network management

Service name Description

IPsec/Firewall Provides network-layer security on IPv4 and IPv6 networks. A firewall provides
simple control of IP traffic. IPsec provides additional protection through
authentication and encryption protocols.

Kerberos Allows you to exchange private information across an open network by assigning a
unique key, called a ticket, to each user who logs on to the network. The ticket is
then embedded in messages to identify the sender.

SNMP v3 Employs a user-based security model for SNMP v3, which provides user
authentication and data privacy through encryption.

SSL/TLS Allows you to transmit private documents via the Internet and guarantee privacy
and data integrity between the client and server applications.

IPsec batch configuration Provides network-layer security through the simple control of IP traffic to and from
the product. This protocol provides the benefits of encryption and authentication
and allows for multiple configurations.
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Install the product on a wired network with Windows

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. At the product control panel, press the Home  button.

4. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

● Configuration Page
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5. Find the IP address on the Embedded Jetdirect page.

Jetdirect Page HP Color LaserJet
Page 1

6. IPv4: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure
the IP address. Otherwise, the network configuration was successful.

IPv6: If the IP address begins with "fe80:", the product should be able to print. If not, you must
manually configure the IP address.

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Follow the onscreen instructions.

4. When prompted, select the Connect through a wired network option.

5. From the list of available printers, select the printer that has the correct IP address.

6. At the end of the installation, click the Finish button, or click the More Options button to install
more software.

7. Print a page from any program to make sure that the software is correctly installed.
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Configure network settings with Windows

View or change network settings

Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx

● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits. It
has a format similar to this:

xxxx::xxxx:xxxx:xxxx:xxxx

2. To open the embedded Web server, type the IP address into the address line of a Web browser.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Set or change the network password

Use the embedded Web server to set a network password or change an existing password.

1. Open the embedded Web server, click the Networking tab, and click the Security link.

NOTE: If a password has previously been set, you are prompted to type the password. Type the
password, and then click the Apply button.

2. Type the new password in the New Password box and in the Verify password box.

3. At the bottom of the window, click the Apply button to save the password.
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Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel Administration menus to manually set an IPv4 address, subnet mask, and
default gateway.

1. At the control panel, press the Home  button.

2. Open each of the following menus:

● Administration

● Network Settings

● Jetdirect Menu

● TCP/IP

● IPv4 Settings

● Config Method

● Manual

● Manual Settings

● IP Address, Subnet Mask, or Default Gateway

3. Use the numeric keypad, or press the up arrow  or the down arrow  to increase or decrease
the number for the first byte of the IP address, subnet mask, or default gateway.

4. Press the OK button to move to the next set of numbers. To move to the previous set of numbers,
press the back arrow .

5. Repeat steps 3 and 4 until the IP address, subnet mask, or default gateway is complete, and then
press the OK button to save the setting.
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Manually configure IPv6 TCP/IP parameters from the control panel

Use the control-panel Administration menus to manually set an IPv6 address.

1. At the control panel, press the Home  button.

2. To enable manual configuration, open each of the following menus:

● Administration

● Network Settings

● Jetdirect Menu

● TCP/IP

● IPv6 Settings

● Address

● Manual Settings

● Enable

Select the On option, and then press the OK button.

3. To configure the address, open each of the following menus:

● Administration

● Network Settings

● Jetdirect Menu

● TCP/IP

● IPv6 Settings

● Address

Use the numeric keypad, or press the up arrow  or the down arrow  to enter the address. Press
the OK button.

NOTE: If you are using the arrow buttons, you must press the OK button after entering each
digit.
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Link speed and duplex settings

The link speed and communication mode of the print server must match the network. For most situations,
leave the product in Auto mode. Incorrect changes to the link speed and duplex settings might prevent
the product from communicating with other network devices. If you need to make changes, use the
product control panel.

NOTE: Making changes to these settings causes the product to turn off and then on. Make changes
only when the product is idle.

1. At the control panel, press the Home  button.

2. Open each of the following menus:

● Administration

● Network Settings

● Jetdirect Menu

● Link Speed

3. Select one of the following options.

Setting Description

Auto The print server automatically configures itself for the highest link speed and
communication mode allowed on the network.

10T Half 10 megabytes per second (Mbps), half-duplex operation

10T Full 10 Mbps, full-duplex operation

100TX Half 100 Mbps, half-duplex operation

100TX Full 100 Mbps, full-duplex operation

100TX Auto Limits auto-negotiation to a maximum link speed of 100 Mbps

1000T Full 1000 Mbps, full-duplex operation

4. Press the OK button. The product turns off and then on.
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6 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size in Windows

● Supported paper sizes

● Supported paper types

● Tray and bin capacity

● Load paper trays

● Configure trays
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Understand paper use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause poor print quality,
increased jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.

Special paper guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in the printer driver
to obtain the best results.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the
product.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner of
the envelope.

● Use peel-off adhesive strips that are
approved for use in laser printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have
wrinkles or bubbles, or are
damaged.

● Do not print partial sheets of labels.

Transparencies ● Use only transparencies that are
approved for use in color laser
printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.
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Media type Do Do not

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.
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Change the printer driver to match the paper type
and size in Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

5. Select a paper type from the Paper type drop-down list.

6. Click the OK button.
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Supported paper sizes
This product supports a number of paper sizes, and it adapts to various media.

NOTE: To obtain best results, select the correct paper size and type in the printer driver before
printing.

Table 6-1  Supported paper and print media sizes

Size and dimensions Tray 1 Tray 2 Tray 3 (optional)

Letter

215.9 x 279 mm (8.5 x 11 in)

Legal

215.9 x 355.6 mm (8.5 x 14 in)

 

A4

210 x 297 mm (8.27 x 11.69 in)

RA4

215 x 305 mm (8.47 x 12.01 in)

 

A5

148 x 210 mm (5.83 x 8.27 in)

B5 (JIS)

182 x 257 mm (7.17 x 10.12 in)

B6 (JIS)

128 x 182 mm (5.04 x 7.17 in)

 

Executive

184.2 x 266.7 mm (7.25 x 10.5 in)

Statement

140 x 216 mm (5.5 x 8.5 in)

 

4x6

101.6 x 152.4 mm (4 x 6 in)

 

10 x 15 cm

101.6 x 152.4 mm (4 x 6 in)

 

3x5

76.2 x 127.0 mm (3.0 x 5.0 in)

  

5x7

127 x 177.8 mm (5 x 7 in)
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Table 6-1  Supported paper and print media sizes (continued)

Size and dimensions Tray 1 Tray 2 Tray 3 (optional)

5x8

127 x 203.2 mm (5 x 8 in)

 

A6

105 x 148 mm (4.13 x 5.83 in)

 

Postcard (JIS)

100 x 148 mm (3.94 x 5.83 in)

  

Double Postcard (JIS)

148 x 200 mm (5.83 x 7.87 in)

 

16K

184 x 260 mm (7.24 x 10.24 in)

16K

195 x 270 mm (7.68 x 10.63 in)

16K

197 x 273 mm (7.8 x 10.8 in)

8.5 x 13

215.9 x 330.2 mm (8.5 x 13 in)

 

Envelope Commercial #10

104.9 x 241.3 mm (4.13 x 9.49 in)

  

Envelope #9

98.43 mm x 225.43 mm (3.88 x 8.88 in)

  

Envelope B5

176 x 250 mm (6.93 x 9.84 in)

  

Envelope C5 ISO

162 x 229 mm (6.93 x 9.84 in)

  

Envelope C6

114 x 162 mm (4.49 x 6.38 in)

  

Envelope DL ISO

110 x 220 mm (4.33 x 8.66 in)

  

Envelope Monarch

98.4 x 190.5 mm (3.88 x 7.5 in)
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Table 6-1  Supported paper and print media sizes (continued)

Size and dimensions Tray 1 Tray 2 Tray 3 (optional)

Custom

76.2 x 127 mm to 215.9 x 355.6 mm (3.0 x 5.0 in to
8.5 x 14 in)

  

Custom

101.6 x 148 mm to 215.9 x 297 mm (4.0 x 5.85 in to 8.5
x 11.69 in)

  

Custom

148 x 215.9 mm to 210 x 355.6 mm (5.83 x 8.5 in to
8.27 x 14 in)
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Supported paper types
For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/
lj500colorM551.

Paper type Tray 1 Tray 21 Tray 3 (optional)

Plain Paper

Light 60–74 g/m2

Midweight (96–110 g/m2)

Heavy (111–130 g/m2)

Extra Heavy (131–175 g/m2)

Color Transparency

Labels

Letterhead

Preprinted

Prepunched

Colored

Rough

Bond

Recycled

Envelope   

Cardstock

Mid-weight glossy (96–110 g/m2)

Heavy glossy (111–130 g/m2)

Extra-heavy glossy (131–175 g/m2)

Card glossy (176–220 g/m2)

Opaque film

HP EcoSMART Lite Paper

HP Tough Paper

HP Matte (105 g/m2)
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Paper type Tray 1 Tray 21 Tray 3 (optional)

HP Matte (120 g/m2)

HP Matte (160 g/m2)

HP Matte (200 g/m2)

HP Soft Gloss (120 g/m2)

HP Glossy (130 g/m2)

HP Glossy (160 g/m2)

HP Glossy (220 g/m2)

1 The stack height for Tray 2 is 30 mm (1.18 in) for glossy paper and 40 mm (1.57 in) for short paper (A5, A6, 4x6, and
landscape).
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Tray and bin capacity
To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray full indicator. For
short/narrow and heavy/glossy paper, load paper to less than half of the tray full indicators.

Tray or bin Paper type Specifications Quantity

Tray 1 Paper Range:

60 g/m2 (16 lb) bond to 220 g/m2

(58 lb) bond

Maximum stack height: 10 mm
(0.39 in)

Equivalent to 100 sheets of 75 g/m2

(20 lb) bond

Envelopes Less than 60 g/m2 (16 lb) bond to
90 g/m2 (24 lb) bond

Up to 10 envelopes

Labels Maximum: 0.102 mm (0.004 in) thick Maximum stack height: 10 mm
(0.39 in)

Transparencies Minimum: 0.102 mm (0.004 in) thick Maximum stack height: 10 mm
(0.39 in)

Up to 50 sheets

Glossy paper Range:

105 g/m2 (28 lb) bond to 220 g/m2

(58 lb) bond

Maximum stack height: 10 mm (0.39
in)

Up to 50 sheets

Tray 2 Paper Range:

60 g/m2 (16 lb) bond to 220 g/m2

(59 lb) bond

Equivalent to 500 sheets of 75 g/m2

(20 lb) bond

Maximum stack height: 56 mm (2.2 in)

For A5, A6, and 4x6 paper sizes, and
for paper printed in a landscape
orientation the maximum stack height is
40 mm (1.57 in),

Labels Maximum: 0.102 mm (0.004 in) thick Maximum stack height: 56 mm (2.2 in)

Transparencies Minimum: 0.102 mm (0.004 in) thick Maximum stack height: 56 mm (2.2 in)

Glossy paper Range:

105 g/m2 (28 lb) bond to 220 g/m2

(58 lb) bond

Maximum stack height: 30 mm (1.18
in)
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Tray or bin Paper type Specifications Quantity

Tray 3 Paper Range:

60 g/m2 (16 lb) bond to 220 g/m2

(59 lb) bond

Equivalent to 500 sheets of 75 g/m2

(20 lb) bond

Maximum stack height: 56 mm (2.2 in)

Labels Maximum: 0.102 mm (0.004 in) thick Maximum stack height: 56 mm (2.2 in)

Transparencies Minimum: 0.102 mm (0.004 in) thick Maximum stack height: 56 mm (2.2 in)

Glossy paper Range:

105 g/m2 (28 lb) bond to 220 g/m2

(58 lb) bond

Maximum stack height: 56 mm (2.2 in)

Output bin Paper  Up to 300 sheets of 75 g/m2 (20 lb)
bond
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Load paper trays

Load Tray 1

1. Open Tray 1.  

2. Slide out the tray extension.  

3. Fold out the tray extension to support the
paper and set the side guides to the correct
width.
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4. Load paper in the tray face down and the
short, top edge going into the product first.

 

5. Make sure the stack fits under the tabs on the
guides and does not exceed the tray-full
indicators.

 

6. Adjust the side guides so that they lightly touch
the paper stack but do not bend it.
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Print envelopes

If your software does not automatically format an envelope, specify Landscape for page orientation in
your software program or printer driver. Use the following guidelines to set margins for return and
destination addresses on Commercial #10 or DL envelopes:

Address type Left margin Top margin

Return 15 mm (0.6 in) 15 mm (0.6 in)

Destination 102 mm (4 in) 51 mm (2 in)

For envelopes of other sizes, adjust the margin settings accordingly.

Load Tray 2

This tray holds up to 500 sheets of 75 g/m2 (20 lb) paper. If the paper is heavier, the tray does not
hold as many sheets. Do not overfill the tray.

The stack height for Tray 2 is 30 mm (1.18 in) for glossy paper and 40 mm (1.57 in) for short paper
(A5, A6, 4x6, and landscape).

CAUTION: Do not print envelopes, labels, postcards, or unsupported sizes of paper from the Tray 2.
Print these types of paper only from Tray 1.

1. Slide open the tray.

NOTE: Do not open the tray while it is in
use.

 

2. Adjust the paper-length and paper-width
guides by squeezing the adjustment latch and
sliding the guides to the size of the paper
being used.
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3. Load paper into the tray face up. Check the
paper to verify the guides lightly touch the
stack, but do not bend it.

NOTE: To prevent jams, do not overfill the
tray. Be sure the top of the stack is below the
tray full indicator.

NOTE: If the tray is not adjusted correctly,
an error message might appear during
printing or the paper might jam.

 

4. Slide the tray into the product.  

5. The control panel shows the tray’s paper type
and size. If the configuration is not correct,
follow the instructions on the control panel to
change the size or type.

 

Load the optional 500-sheet paper and heavy media tray (Tray 3)

Tray 3 holds up to 500 sheets of standard paper.

The product automatically detects the following standard sizes of paper in Tray 3: Letter, Legal,
Executive, A4, A5, and B5 (JIS).

CAUTION: Do not print envelopes or unsupported sizes of paper from Tray 3. Print these types of
paper only from Tray 1.
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Load standard-sized paper into Tray 3

1. Slide open the tray.

NOTE: Do not open the tray while it is in
use.

 

2. Adjust the paper-length and paper-width
guides by squeezing the adjustment latches
and sliding the guides to the size of the paper
being used.

 

3. Load paper into the tray face up. Check the
paper to verify the guides lightly touch the
stack, but do not bend it.

NOTE: To prevent jams, do not overfill the
tray. Be sure the top of the stack is below the
tray full indicator.

NOTE: If the tray is not adjusted correctly,
an error message might appear during
printing or the paper might jam.
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4. Slide the tray into the product.  

5. The control panel shows the tray’s paper type
and size. If the configuration is not correct,
follow the instructions on the control panel to
change the size or type.

 

Load custom-size paper into Tray 3

1. Slide open the tray.  
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2. Adjust the paper-length and paper-width
guides by squeezing the adjustment latches
and sliding the guides to the size of the paper
being used.

 

3. Load paper into the tray face up. Check the
paper to verify the guides lightly touch the
stack, but do not bend it.
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4. Slide the tray into the product. The control
panel shows the paper type and size.

 

5. The control panel prompts you to set the paper
size and type. Select the Custom setting, and
then configure the X and Y dimensions of the
custom paper size.

 

NOTE: See the label in the paper tray, or the following illustration, to determine the X and Y
dimensions.

Y
X
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Paper orientation for loading trays

If you are using paper that requires a specific orientation, load it according to the information in the
following tables.

NOTE: The Alternative Letterhead Mode setting affects the way you load letterhead or
preprinted paper. This setting is disabled by default.

Tray 1

Paper type Image
orientation

Duplex mode How to load paper

Alternative Letterhead
Mode = Disabled

How to load paper

Alternative Letterhead
Mode = Enabled

Preprinted or
letterhead

Portrait 1-sided printing Face down

Top edge leading into the
product

Face up

Bottom edge leading into the
product

  2-sided printing Face up

Bottom edge leading into the
product

Face up

Bottom edge leading into the
product

 Landscape 1-sided printing Face up

Top edge toward the front of the
product

Face up

Top edge toward the front of the
product
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Paper type Image
orientation

Duplex mode How to load paper

Alternative Letterhead
Mode = Disabled

How to load paper

Alternative Letterhead
Mode = Enabled

  2-sided printing Face up

Top edge toward the front of the
product

Face up

Top edge toward the front of the
product

Prepunched Portrait or landscape 1- or 2-sided printing Holes toward the back of the
product

Not applicable

Envelopes Long edge of the
envelope feeding
into the product

1-sided printing Face down

Top edge leading into the
product

Not applicable

 Short edge of the
envelope feeding
into the product

1-sided printing Face down

Top edge toward the back of the
product

Not applicable
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Tray 2 or optional Tray 3

Paper type Image
orientation

Duplex mode How to load paper

Alternative Letterhead
Mode = Disabled

How to load paper

Alternative Letterhead
Mode = Enabled

Preprinted or
letterhead

Portrait 1-sided printing Face up

Top edge at the right side of the
tray

Face up

Top edge at the right side of the
tray

  2-sided printing Face down

Top edge at the left side of the
tray

Face down

Top edge at the left side of the
tray

 Landscape 1-sided printing Face up

Top edge toward the back of the
product

Face up

Top edge toward the back of the
product
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Paper type Image
orientation

Duplex mode How to load paper

Alternative Letterhead
Mode = Disabled

How to load paper

Alternative Letterhead
Mode = Enabled

  2-sided printing Face down

Top edge toward the front of the
product

Face down

Top edge toward the front of the
product

Prepunched Portrait or landscape 1- or 2-sided printing Holes toward the back of the
product

Not applicable
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Configure trays
The product automatically prompts you to configure a tray for type and size in the following situations:

● When you load paper into the tray

● When you specify a particular tray or media type for a print job through the printer driver or a
software program and the tray is not configured to match the print-job’s settings

NOTE: The prompt does not appear if you are printing from Tray 1, and it is configured for the Any
Size and Any Type settings. In this situation, if the print job does not specify a tray, the product prints
from Tray 1, even if the paper size and type settings in the print job do not match the paper loaded in
Tray 1.

Configure a tray when loading paper

1. Load paper in the tray. Close the tray if you are using Tray 2 or 3.

2. The tray configuration message appears.

3. Do one of the following:

● Press the OK button to accept the size and type.

● To modify the tray size configuration, press the down arrow  to highlight the Modify
option, and then press the OK button.

a. Press the down arrow  to highlight the correct size, and then press the OK button.

b. Press the down arrow  to highlight the correct type, and then press the OK button.

Configure a tray to match print job settings

1. In the software program, specify the source tray, the paper size, and the paper type.

2. Send the job to the product.

If the tray needs to be configured, the tray configuration message appears.

3. Load the tray with the specified size and type of paper, and then close the tray.

4. When the size and type confirmation messages appear, press the OK button to confirm the paper
size and type.

Configure a tray from the control panel

You can also configure the trays for size and type without a prompt from the product.

1. Press the Home  button.

2. Open the Trays menu.

3. Press the down arrow  to highlight the size or type setting for the desired tray, and then press the
OK button.
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4. Press the up arrow  or the down arrow  to highlight the size or type. If you select a custom
size, select the unit of measure, and then set the X dimension and the Y dimension.

5. Press the OK button to save your selection.

6. Press the Home  button to exit the menus.

Automatic overhead transparency sensing (auto sense mode)

The automatic media type sensor functions only when that tray is configured to the Any Type setting.
Configuring a tray to any other type, such as Bond or Glossy, deactivates the media sensor in that tray.

The product can automatically classify paper types into one of two categories:

● Non-transparency

● Transparency

For more control, a specific type must be selected in the job or configured in a tray.

Auto-sense settings

Full sensing (Tray 1 only)

● The product distinguishes between transparencies (Transparency mode) and paper (Normal
mode).

● Each time the product prints a page, it senses transparencies or non-transparencies.

● This is the slowest mode.

Transparency only

● The product distinguishes between transparencies (Transparency mode) and paper (Normal
mode).

● The product assumes that the second and all subsequent pages are of the same media type as the
first page.

● This is the fastest mode and is useful for high-volume printing in Normal mode.

Select the paper by source, type, or size

In the Microsoft Windows operating system, three settings affect how the printer driver tries to pull
media when you send a print job. Source, Type, and Size settings appear in the Page Setup, Print,
Preferences, or Print Properties dialog boxes in most software programs. Unless you change
these settings, the product automatically selects a tray using the default settings.

Source

To print by source, select a specific tray in the printer driver for the product to pull from. If you select a
tray that is configured for a type or size that does not match your print job, the product prompts you to
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load the tray with the type or size of paper for your print job before printing it. When you load the
tray, the product begins printing.

Type and size

● Printing by type or size causes the product to pull from the tray that is loaded with the correct type
and size of paper.

● Selecting paper by type rather than source helps protect special paper from accidental use.

● Using the wrong setting might result in unsatisfactory print quality. Always print by type for special
print media, such as labels or transparencies.

● Print by type or size for envelopes, if possible.

● To print by type or size, select the type or size from the Page Setup dialog box, the Print
dialog box, the Preferences dialog box, or the Print Properties dialog box, depending on
the software program.

● If you often print on a certain type or size of paper, configure a tray for that type or size. Then,
when you select that type or size as you print a job, the product automatically pulls paper from the
tray that is configured for that type or size.
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Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Supplies information

Color Cartridge number Part number

Standard-capacity replacement black
print cartridge

507A CE400A

High-capacity replacement black print
cartridge

507X CE400X

Replacement cyan print cartridge 507A CE401A

Replacement yellow print cartridge 507A CE402A

Replacement magenta print cartridge 507A CE403A

Environmental features: Recycle print cartridges by using the HP Planet Partners return and
recycling program.

For more information about supplies, go to www.hp.com/go/learnaboutsupplies.

The information contained herein is subject to change without notice. For the latest supplies information
go to www.hp.com/support/lj500colorM551_manuals.
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Supplies views

Print cartridge views

3

1
2

1 Plastic shield

2 Imaging drum

3 Print cartridge memory tag
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Manage print cartridges
Correctly using, storing, and monitoring the print cartridge can help ensure high-quality print output.

Change settings for print cartridges

Print when a print cartridge is at or near end of life

● A <Color> <Supply> Low message—where <Color> is the color of the supply, and <Supply>
is the type of supply—appears when a supply is nearing the estimated end of its useful life.

● A <Color> <Supply> Very Low message appears when a supply is at its estimated end of
useful life.

Print-quality problems can occur when using a supply that is at its estimated end of life.

Enable or disable the Very Low Settings options from the control panel

You can enable or disable the default settings at any time, and you do not have to re-enable them
when you install a new cartridge.

CAUTION: Once an HP supply has reached Very Low, the HP premium Protection Warranty on that
supply has ended.

1. At the control panel, press the Home  button.

2. Open the following menus:

● Administration

● Manage Supplies

● Supply Settings

● Black Cartridge or Color Cartridges

● Very Low Settings

3. Use the arrow buttons to highlight your selection, and then press the OK button to select it. Select
one of the following options:

NOTE: If you select the Stop or Prompt to continue option, the product stops printing when
it reaches the Very Low threshold. When you replace the cartridge, the product automatically
resumes printing.

● Select the Stop option to set the product to stop printing until you replace the cartridge.

● Select the Prompt to continue option to set the product to stop printing and prompt you to
replace the cartridge. You can acknowledge the prompt and continue printing.

● Select the Continue option to set the product to alert you that the cartridge is very low, but
to continue printing.
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NOTE: Using the Continue setting allows printing beyond Very Low and can result in
unsatisfactory print quality.

Store and recycle supplies

Recycle supplies

To recycle a genuine HP print cartridge, place the used cartridge in the box in which the new cartridge
arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete
information, see the recycling guide that is included with each new HP supply item.

Print-cartridge storage

Do not remove the print cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes.

HP policy on non-HP print cartridges

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured.

NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty and
service agreements.

HP anticounterfeit Web site

Go to www.hp.com/go/anticounterfeit when you install an HP print cartridge and the control-panel
message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps
to resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).
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Replacement instructions

Replace the print cartridge

The product uses four colors and has a different print cartridge for each color: black (K), magenta (M),
cyan (C), and yellow (Y).

CAUTION: If toner gets on clothing, wipe it off with a dry cloth and wash the clothes in cold water.
Hot water sets toner into fabric.

NOTE: Information about recycling used print cartridges is on the print-cartridge box.

1. Open the front door. Make sure that the door
is completely open.

 

2. Grasp the handle of the used print cartridge
and pull out to remove.

 

3. Store the used print cartridge in a protective
bag. Information about recycling used print
cartridges is on the print-cartridge box.
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4. Remove the new print cartridge from its
protective bag.

 

5. Grasp both sides of the print cartridge and
distribute the toner by gently rocking the print
cartridge.

 

6. Remove the orange protective cover from the
print cartridge.

CAUTION: Avoid prolonged exposure to
light.

CAUTION: Do not touch the green roller.
Doing so can damage the cartridge.
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7. Align the print cartridge with its slot and insert
the print cartridge until it clicks into place.

 

8. Close the front door.  

Replace the toner collection unit

Replace the toner collection unit when the control panel prompts you.

NOTE: The toner collection unit is designed for a single use. Do not attempt to empty the toner
collection unit and reuse it. Doing so could lead to toner being spilled inside the product, which could
result in reduced print quality. After use, return the toner collection unit to HP’s Planet Partners program
for recycling.

NOTE: If printing documents that require heavy toner coverage, the toner collection unit can fill
quickly. If printing these types of documents, HP recommends that you have another toner collection unit
available.

1. Open the front door. Make sure that the door
is completely open.
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2. Grasp the blue label at the top of the toner
collection unit and remove it from the product.

 

3. Place the attached blue cap over the blue
opening at the top of the unit.

 

4. Remove the new toner collection unit from its
packaging.
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5. Insert the bottom of the new unit into the
product first and then push the top of the unit
until it clicks into place.

 

6. Close the front door.

NOTE: If the toner collection unit is not
installed correctly, the front door does not
close completely.

 

To recycle the used toner collection unit, follow the instructions included with the new toner collection
unit.
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Solve problems with supplies

Check the print cartridges

Check the print cartridge, and replace it if necessary, if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

If you determine that you need to replace a print cartridge, print the supplies status page to find the
part number for the correct genuine HP print cartridge.

Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett-Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured
print cartridge and are not satisfied with the print quality, replace the cartridge with
a genuine HP cartridge.

Genuine HP print cartridge 1. The product control panel or the supplies status page indicates Very Low
status when the cartridge has reached the end of its designated life. Replace
the print cartridge if print quality is no longer acceptable.

2. Visually inspect the print cartridge for damage. See the instructions that follow.
Replace the print cartridge if necessary.

3. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the
repeating defects information in this document to identify the cause of the
problem.
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Inspect the print cartridge for damage

1. Check if the memory chip is damaged or missing.

2. Examine the surface of the green imaging drum on the top of the print cartridge.

CAUTION: Do not touch the green roller (imaging drum) on the top of the cartridge.
Fingerprints on the imaging drum can cause print-quality problems.

3. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the print
cartridge.

4. If the imaging drum does not appear to be damaged, reinstall the print cartridge. Print a few
pages to see if the problem has resolved.
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Repeating defects

If defects repeat at regular intervals on the page, use a ruler and the table below to identify the cause
of the defect. Place the top of the ruler at the first defect. The marking that is beside the next occurrence
of the defect indicates which component needs to be replaced.

Distance between defects Product components that cause the defect

27 mm Print cartridge (primary charging roller)

32 mm Print cartridge (developer roller)

44 mm Print engine (primary transfer roller)

49 mm Print cartridge (replenishing/supply roller)

50 mm Print engine (secondary transfer roller)

76 mm Print cartridge (OPC)

77 mm Fuser (fuser film)

78 mm Fuser (pressure roller)

Print the Supplies Status page

The Print Supplies Status page indicates the estimated life remaining in print cartridges. It also lists
the part number for the correct genuine HP print cartridge for your product so you can order a
replacement print cartridge, as well as other useful information.

1. At the control panel, press the Home  button.

2. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

3. Use the down arrow button  to highlight the Supplies Status Page item, and then press the
OK button to select it.

4. Use the up arrow button  to highlight the Print item, and then press the OK button.
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Interpret control panel messages for supplies

The following table contains important information about supplies status messages.

10.XX.YY Supply memory error

Description

The product cannot read or write to at least one print-cartridge memory chip or a memory chip is
missing from a print cartridge.

Memory chip memory errors

◦ YY = 00

◦ XX = 00 - Black

◦ XX = 01 - Cyan

◦ XX = 02 - Magenta

◦ XX = 03 - Yellow

Memory chip missing errors

◦ YY = 10

◦ XX = 00 - Black

◦ XX = 01 - Cyan

◦ XX = 02 - Magenta

◦ XX = 03 - Yellow

Recommended action

Reinstall the print cartridge, or install a new print cartridge.

Black cartridge low

Description

The print cartridge is nearing the estimated end of its useful life.

Recommended action

The product indicates when the print-cartridge level is low. The actual print-cartridge life remaining can
vary. Consider having a replacement cartridge available to install when the print quality is no longer
acceptable. The print cartridge does not need to be replaced now.
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Black cartridge very low

Description

The print cartridge is at the estimated end of its useful life.

Print quality might decrease. Replace the print cartridge when the print quality becomes unacceptable.

Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You do not
need to replace the print cartridge at this time unless the print quality is no longer acceptable. The
actual print-cartridge life can vary.

Once an HP print cartridge has reached the very low threshold, the HP Premium Protection Warranty
on that print cartridge has ended. When choosing to continue printing past the very low threshold, all
print defects or print-cartridge failures will not be considered to be defects in materials or workmanship
in the print cartridge under the HP Print Cartridge Warranty Statement.

Cyan cartridge low

Description

The print cartridge is nearing the estimated end of its useful life.

Recommended action

The product indicates when the print-cartridge level is low. The actual print-cartridge life remaining can
vary. Consider having a replacement cartridge available to install when the print quality is no longer
acceptable. The print cartridge does not need to be replaced now.

Cyan cartridge very low

Description

The print cartridge is at the estimated end of its useful life.

Print quality might decrease. Replace the print cartridge when the print quality becomes unacceptable.

Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You do not
need to replace the print cartridge at this time unless the print quality is no longer acceptable. The
actual print-cartridge life can vary.

Once an HP print cartridge has reached the very low threshold, the HP Premium Protection Warranty
on that print cartridge has ended. When choosing to continue printing past the very low threshold, all
print defects or print-cartridge failures will not be considered to be defects in materials or workmanship
in the print cartridge under the HP Print Cartridge Warranty Statement.
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Fuser kit low

Description

The fuser kit is low. The actual supply life remaining might vary. Consider having a replacement fuser
kit available to install when print quality is no longer acceptable. You do not need to replace the fuser
kit at this time unless print quality is no longer acceptable.

Recommended action

If print quality is no longer acceptable, replace the fuser kit. Instructions are included with the fuser kit.

Fuser kit very low

Description

The fuser kit is very low. The actual supply life remaining might vary. You do not need to replace the
fuser kit at this time unless print quality is no longer acceptable. After an HP supply has reached the
very low threshold, the HP Premium Protection Warranty for that supply has ended.

Recommended action

If print quality is no longer acceptable, replace the fuser kit. Instructions are included with the fuser kit.

Incompatible <color> cartridge

Description

The indicated color print cartridge is not compatible with this product.

Recommended action

Replace the print cartridge with one that is designed for this product.

Incompatible fuser

Description

The fuser is not compatible with this product.

Recommended action

WARNING! The fuser can be hot while the product is in use. Wait for the fuser to cool before
handling it.

1. Open the right door.

2. Remove the incompatible fuser.

3. Install the correct fuser.

4. Close the right door.
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Magenta cartridge low

Description

The print cartridge is nearing the estimated end of its useful life.

Recommended action

The product indicates when the print-cartridge level is low. The actual print-cartridge life remaining can
vary. Consider having a replacement cartridge available to install when the print quality is no longer
acceptable. The print cartridge does not need to be replaced now.

Magenta cartridge very low

Description

The print cartridge is at the estimated end of its useful life.

Print quality might decrease. Replace the print cartridge when the print quality becomes unacceptable.

Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You do not
need to replace the print cartridge at this time unless the print quality is no longer acceptable. The
actual print-cartridge life can vary.

Once an HP print cartridge has reached the very low threshold, the HP Premium Protection Warranty
on that print cartridge has ended. When choosing to continue printing past the very low threshold, all
print defects or print-cartridge failures will not be considered to be defects in materials or workmanship
in the print cartridge under the HP Print Cartridge Warranty Statement.

Replace <color> cartridge

Description

This alert appears only if the product is configured to stop when the print cartridge reaches the very low
threshold. The product indicates when a supply level is at its estimated end of life. The actual life
remaining might be different than the estimation. Have a replacement supply available to install when
print quality is no longer acceptable. The supply does not need to be replaced now unless the print
quality is no longer acceptable. After an HP supply has reached its approximated end of life, the HP
Premium Protection Warranty on that supply ends.

Recommended action

Replace the specified color cartridge.

Or, configure the product to continue printing by using the Manage Supplies menu.

Replace fuser kit

Description

The product indicates when the fuser kit is at its estimated end of life. The actual life remaining might be
different than the estimation. Have a replacement fuser kit available to install when print quality is no
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longer acceptable. The fuser kit does not need to be replaced now unless the print quality is no longer
acceptable. After the fuser kit reaches its approximated end of life, the HP Premium Protection
Warranty on that fuser kit ends.

Recommended action

WARNING! The fuser can be hot while the product is in use. Wait for the fuser to cool before
handling it.

Replace the fuser kit. Instructions are included with the fuser kit.

Replace Supplies

Description

This alert appears only if the product is configured to stop when the print cartridges reach the "very
low" threshold. Two or more supplies are at the estimated end of life. The actual life remaining might
be different than the estimation. Consider having replacement supplies available to install when print
quality is no longer acceptable. The supply does not need to be replaced now unless the print quality is
no longer acceptable. After an HP supply has reached its approximated end of life, the HP Premium
Protection Warranty on that supply ends.

Recommended action

Replace the necessary supplies.

Or, configure the product to continue printing by using the Manage Supplies menu.

Replace toner collection unit

Description

The product indicates when a toner collection unit is at its estimated end of life. The actual life
remaining might be different than the estimation. It is best to replace the toner collection unit within two
weeks of the message to avoid overfilling and possible toner spill. After a toner collection unit has
reached its approximated end of life, HP’s premium Protection Warranty on that toner collection unit
ends.

Recommended action

Replace the toner collection unit.

If you wish to have the toner collection unit operate past its estimated capacity, configure the product to
continue printing by using the Manage Supplies menu. This is not a recommended option because
of the risk of overfilling the toner collection unit, which could result in the need to service the product.

Replace toner collection unit

Description

The product indicates when a toner collection unit is at its estimated end of life. The actual life
remaining might be different than the estimation. It is best to replace the toner collection unit within two
weeks of the message to avoid overfilling and possible toner spill. After a toner collection unit has
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reached its approximated end of life, HP’s premium Protection Warranty on that toner collection unit
ends.

Recommended action

Replace the toner collection unit.

If you wish to have the toner collection unit operate past its estimated capacity, configure the product to
continue printing by using the Manage Supplies menu. This is not a recommended option because
of the risk of overfilling the toner collection unit, which could result in the need to service the product.

Supplies in wrong position

Description

Two or more print-cartridge slots contain the wrong color print cartridge.

From left to right, the print cartridges should be installed in this order:

◦ Yellow

◦ Magenta

◦ Cyan

◦ Black

Recommended action

Install the correct color cartridge in each slot.

Supplies low

Description

This message appears when at least two supplies have reached the low threshold. The actual supply life
remaining might vary. Identify which supplies are low. You do not need to replace the supplies at this
time unless print quality is no longer acceptable. After an HP supply has reached the very low
threshold, the HP Premium Protection Warranty for that supply has ended.

Recommended action

To continue printing in color, either replace the supply or reconfigure the product by using the
Manage Supplies menu on the control panel.

Supplies very low

Description

This message appears when at least two supplies have reached the very low threshold. Identify which
supplies are low. The actual supply life remaining might vary. You do not need to replace the supplies
at this time unless print quality is no longer acceptable. After an HP supply has reached the very low
threshold, the HP Premium Protection Warranty for that supply has ended.
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Recommended action

To continue printing in color, either replace the supply or reconfigure the product by using the
Manage Supplies menu on the control panel.

Toner Collection Unit Almost Full

Description

The toner collection unit is almost full. This condition is equivalent to the supply life being low. The
actual supply life can vary. You do not need to replace the toner collection unit at this time.

Recommended action

No action is necessary to continue. Consider ordering another toner collection unit.

Unsupported supply installed

Description

One of the print cartridges is for a different HP product.

Recommended action

Remove the print cartridge from that slot, and install a cartridge that is for the HP product.

Used supply in use

Description

One of the print cartridges has been previously used.

Recommended action

If you believe you purchased a genuine HP supply, go to www.hp.com/go/anticounterfeit.

Wrong cartridge in <color> slot

Description

The indicated slot for a print cartridge contains a cartridge that is not the correct color. From left to
right, the print cartridges should be installed in this order:

◦ Yellow

◦ Magenta

◦ Cyan

◦ Black

Recommended action

Remove the print cartridge from that slot, and install a cartridge that is the correct color.
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Yellow cartridge low

Description

The print cartridge is nearing the estimated end of its useful life.

Recommended action

The product indicates when the print-cartridge level is low. The actual print-cartridge life remaining can
vary. Consider having a replacement cartridge available to install when the print quality is no longer
acceptable. The print cartridge does not need to be replaced now.

Yellow cartridge very low

Description

The print cartridge is at the estimated end of its useful life.

Print quality might decrease. Replace the print cartridge when the print quality becomes unacceptable.

Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You do not
need to replace the print cartridge at this time unless the print quality is no longer acceptable. The
actual print-cartridge life can vary.

Once an HP print cartridge has reached the very low threshold, the HP Premium Protection Warranty
on that print cartridge has ended. When choosing to continue printing past the very low threshold, all
print defects or print-cartridge failures will not be considered to be defects in materials or workmanship
in the print cartridge under the HP Print Cartridge Warranty Statement.
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8 Print tasks

● Cancel a print job with Windows

● Basic print tasks with Windows

● Use HP ePrint

● Additional print tasks with Windows

● Walk-up USB printing
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Cancel a print job with Windows

1. Press the stop button  on the control panel.  

2. Press the down arrow  to highlight the
Cancel Current Job option, and then press
the OK button.

NOTE: It can take some time for all printing
to clear after you have canceled a print job.
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Basic print tasks with Windows
The methods to open the print dialog from software programs can vary. The procedures that follow
include a typical method. Some software programs do not have a File menu. See the documentation
for your software program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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Get help for any printing option with Windows

1. Click the Help button to open the online Help.  

Change the number of print copies with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then select the number of copies.

Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.
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Create printing shortcuts

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  
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4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, all your adjustments are
lost.

 

5. Select the print options for the new shortcut.  
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6. Click the Save As button.  

7. Type a name for the shortcut, and click the OK
button.
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Improve print quality with Windows

Select the page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

Select a custom page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size, specify the dimensions, and click the OK button.

Select the paper type with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper, and then click the paper type
that you are using.

Select the paper tray with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a tray from the Paper source drop-down list.

Select the print resolution

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.
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3. Click the Paper/Quality tab.

4. In the Print Quality area, select the resolution from the first drop-down list.
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Print on both sides (duplex) with Windows

NOTE: See Paper orientation for loading trays on page 90 for information about the correct way to
load paper.

Manually print on both sides with Windows

NOTE: This information applies only to products that do not have an automatic duplexer.

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the Print on both sides (manually)
check box. Click the OK button to print the
first side of the job.

 

5. Retrieve the printed stack from the output bin,
and place it with the printed-side facing up in
Tray 1.

 

6. On the control panel, press the OK button to
print the second side of the job.

 

Automatically print on both sides with Windows

NOTE: This information applies only to products that have an automatic duplexer.
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1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Select the Print on both sides check box.
Click the OK button to print the job.

 

Print multiple pages per sheet with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from the
Pages per sheet drop-down list.

 

5. Select the correct Print page borders,
Page order, and Orientation options.

 

Select page orientation with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait
or Landscape option.

To print the page image upside down, select
the Rotate by 180 degrees option.

 

ENWW Basic print tasks with Windows 135



Set color options with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Click the HP EasyColor check box to clear it.

5. In the Color Options area, click the Manual option, and then click the Settings button.

6. Adjust the general settings for Edge Control, and settings for text, graphics, and photographs.
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Use HP ePrint
Use HP ePrint to print documents by sending them as an e-mail attachment to the product's e-mail
address from any e-mail enabled device.

NOTE: The product must be connected to a network and have Internet access to use HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.

a. Type the product IP address into the address line of a Web browser to open the
HP Embedded Web Server.

b. Click the Web Services tab.

c. Select the option to enable Web Services.

2. Use the HP ePrintCenter Web site to define security settings and to configure default print settings
for all HP ePrint jobs sent to this product.

a. Go to www.hpeprintcenter.com.

b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.

c. Select your product from the list, or click + Add printer to add it. To add the product, you
need the printer code, which is the segment of the product e-mail address that is before the @
symbol.

NOTE: This code is valid for only 24 hours from the time you enable HP Web Services. If it
expires, follow the instructions to enable HP Web Services again, and obtain a new code.

d. To prevent your product from printing unexpected documents, click ePrint Settings, and
then click the Allowed Senders tab. Click Allowed Senders Only, and add the e-mail
addresses from which you want to allow ePrint jobs.

e. To set up default settings for all ePrint jobs sent to this product, click ePrint Settings, click
Print Options, and select the settings that you want to use.

3. To print a document, attach it to an e-mail message sent to the product's e-mail address.
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Additional print tasks with Windows

Print colored text as black (grayscale) with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Advanced tab.

4. Expand the Document Options section.

5. Expand the Printer Features section.

6. In the Print All Text as Black drop-down list, select the Enabled option.
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Print on preprinted letterhead or forms with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. From the Paper type drop-down list, click the
More... option.

 

5. Expand the list of Type is: options.  
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6. Expand the list of Other options.  

7. Select the option for the type of paper you are
using, and click the OK button.

 

Print on special paper, labels, or transparencies with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.

 

142 Chapter 8   Print tasks ENWW



5. Expand the list of Type is: options.  

6. Expand the category of paper types that best
describes your paper.

NOTE: Labels and transparencies are in the
list of Other options.

 

7. Select the option for the type of paper you are
using, and click the OK button.
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Print the first or last page on different paper with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. In the Special pages area, click the Print
pages on different paper option, and
then click the Settings button.

 

5. In the Pages in document area, select
either the First or Last option.

 

6. Select the correct options from the Paper
source and Paper type drop-down lists.
Click the Add button.
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7. If you are printing both the first and last pages
on different paper, repeat steps 5 and 6,
selecting the options for the other page.

 

8. Click the OK button.  

Scale a document to fit page size with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print document on option, and
then select a size from the drop-down list.
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Add a watermark to a document with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise,
the watermark is printed on each page.
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Create a booklet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the Print on both sides check box.  

5. In the Booklet layout drop-down list, click
the Left binding or Right binding option.
The Pages per sheet option automatically
changes to 2 pages per sheet.

 

Use job storage features with Windows

The following job-storage modes are available for print jobs:

● Proof and Hold: This feature provides a quick way to print and proof one copy of a job and
then print more copies.

● Personal Job: When you send a job to the product, the job does not print until you request it at
the product control panel. If you assign a personal identification number (PIN) to the job, you must
provide the required PIN at the control panel.

● Quick Copy: If the optional hard disk is installed on the product, you can print the requested
number of copies of a job and then store a copy of the job on the optional hard disk. Storing the
job allows you to print additional copies of the job later.

● Stored Job: If the optional hard disk is installed on the product, you can store a job such as a
personnel form, time sheet, or calendar on the product and allow other users to print the job at
any time. Stored jobs also can be protected by a PIN.
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CAUTION: If you turn off the product, all Quick Copy, Proof and Hold, and Personal Job
types of stored jobs are deleted. To permanently store the job and prevent the product from deleting it
when space is needed for something else, select the Stored Job option in the driver.

Create a stored job with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Job Storage tab.  

4. Select a Job Storage Mode option, and
then click the OK button.

 

Print a stored job

1. Press the Home  button.  
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2. Press the down arrow  to highlight the
Retrieve Job From Device Memory
menu, and then press the OK button.

 

3. Press the down arrow  to highlight your user
name, and then press the OK button.

 

4. Press the down arrow  to highlight a job
name, and then press the OK button.

The Print or Delete option is highlighted.

NOTE: If you have stored more than one job
on the product, you have the option to print or
delete all of them at the same time.

 

5. Press the OK button to select the Print or
Delete option.

 

Delete a stored job

When you send a stored job, the product overwrites any previous jobs with the same user and job
name. If a job is not already stored under the same user and job name, and the product needs
additional space, the product might delete other stored jobs starting with the oldest. You can change
the number of jobs that can be stored from the Retrieve Job From Device Memory menu on the
product control panel.

You can delete a job from the control panel, from the HP Embedded Web Server, or from HP Web
Jetadmin. To delete a job from the control panel, use the following procedure:

1. Press the Home  button.

2. Press the down arrow  to highlight the Retrieve Job From Device Memory menu, and then
press the OK button.

3. Press the down arrow  to highlight a job name, and then press the OK button.

4. Press the down arrow  to highlight the Delete option, and then press the OK button.

Set job storage options with Windows

Print one copy for proof before printing all the copies

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Proof and Hold option.
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Temporarily store a personal job on the product and print it later

NOTE: The product deletes the job after you print it.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Personal Job option.

5. Optional: In the Make Job Private area, click the PIN to print option, and enter a 4-digit
personal identification number (PIN).

6. Print the job at any time from the product control panel.

Temporarily store a job on the product

NOTE: This option is available if the optional hard disk is installed in the product.

NOTE: The product stores the job until you turn the product off.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Quick Copy option.

The requested number of copies are printed immediately, and you can print more copies from the
product control panel.

Permanently store a job on the product

NOTE: This option is available if the optional hard disk is installed in the product.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Stored Job option.

Make a permanently stored job private so that anyone who tries to print it must provide a
PIN

NOTE: This option is available if the optional hard disk is installed in the product.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

154 Chapter 8   Print tasks ENWW



3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Stored Job option or the Personal Job option.

5. In the Make Job Private area, click the PIN to print option, and enter a 4-digit personal
identification number (PIN).

NOTE: To print the job or to delete it, you must provide the PIN at the product control panel.

Receive notification when someone prints a stored job

NOTE: Only the person who created the stored job receives notification. You do not receive
notification when someone prints a stored job that another person has created.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. Select the job storage mode that you want.

5. In the Job Notifications Options area, click the Display Job ID when printing option.

Set the user name for a stored job

Follow this procedure to change the user name for a stored job.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. Select the job storage mode that you want.

5. In the User Name area, click the User name option to use the Windows default user name. To
provide a different user name, click the Custom option and type the name.

Specify a name for the stored job

Follow this procedure to change the default name for a stored job.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. Select the job storage mode that you want.

5. To automatically generate the job name associated with the stored document, in the Job Name
area, click the Automatic option. The driver uses the document file name, if it is available. If the
document has no file name, the driver uses the software program name or a time stamp for the job
name.
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To specify a job name, click the Custom option and type the name.

6. Select an option from the If job name exists drop-down list.

● Select the Use Job Name + (1-99) option to add a number to the end of the existing
name.

● Select the Replace Existing File option to overwrite a job that already has that name.

Print special jobs with Windows

Print business graphics or marketing material

You can use this product to print marketing and sales material or other color documents on glossy
paper. To maximize the quality of this output you must do the following:

1. Choose the appropriate paper. See the following table.

2. At the product control panel, configure the paper tray for the correct paper type.

3. Select the corresponding settings in the printer driver.

Supported glossy paper

HP glossy paper product Product code Product size Control panel and print
driver settings

HP Laser Presentation Paper,
Soft Gloss

Q6541A Letter HP Presentation Soft
Gloss 120g

HP Laser Presentation Paper,
Glossy

Q2546A Letter HP Presentation Glossy
130g

HP Laser Presentation Paper,
Glossy

Q2552A A4 HP Presentation Glossy
130g

HP Laser Professional Paper,
Soft Gloss

Q6542A A4 HP Presentation Soft
Gloss 120g

HP Laser Brochure Paper,
Glossy

Q6611A, Q6610A Letter HP Color Laser Brochure
Glossy 160g

HP Laser Superior Paper,
Glossy

Q6616A A4 HP Superior Glossy
160g

HP Laser Photo Paper, Glossy Q6607A, Q6608A Letter HP Color Laser Photo
Glossy 220g

HP Laser Photo Paper, Glossy Q6614A A4 HP Color Laser Photo
Glossy 220g

HP Laser Photo Paper, Glossy
4x6

Q8842A 101.6 x 152.4 mm (4 x 6 in) HP Color Laser Photo
Glossy 220g

HP Laser Photo Paper, Glossy
10 x 15 cm

Q8843A 101.6 x 152.4 mm (4 x 6 in) HP Color Laser Photo
Glossy 220g
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NOTE: In the United States, see www.hp.com/go/paper for a complete list of HP brand paper.

Set the duplex alignment

For documents that are printed on both sides, such as brochures, set the registration for the tray before
printing to ensure that the front and back of the page are aligned.

1. At the product control panel, press the Home  button.

2. Open the following menus:

a. Administration

b. General Settings

c. Print Quality

d. Image Registration

e. Adjust Tray <X>

3. Select the Print Test Page item, and then press the OK button.

4. Follow the instructions on the test page to complete the adjustment.

Print weatherproof maps and outdoor signs

The product can print durable, waterproof maps, signs, or menus by using HP Tough Paper. HP Tough
Paper is a waterproof, tear-proof, satin finish paper that retains rich, vibrant print color and clarity even
when exposed to heavy usage or weather. This avoids expensive and time-consuming lamination. To
maximize the quality of this output, you must do the following:

● Choose the appropriate paper. See the following table.

● At the product control panel, configure the paper tray for the correct paper type.

● Select the corresponding settings in the printer driver.

Supported tough paper

HP paper name Product code Product size Control panel and print
driver settings

HP LaserJet Tough Paper Q1298A Letter HP Tough Paper

HP LaserJet Tough Paper Q1298B A4 HP Tough Paper
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Walk-up USB printing
This product features walk-up USB printing, so you can quickly print files without sending them from a
computer. The product accepts standard USB storage accessories in the USB port on the front of the
product. You can print the following types of files:

NOTE: You must enable this feature by using the control-panel menus or the HP Embedded Web
Server before it can be used.

To enable this feature by using the control-panel menus, access the Administration menu, General
Settings sub menu, Retrieve From USB Settings sub menu, and then select Enable. To enable
this feature by using the HP Embedded Web Server, access the Print tab.

● .pdf

● .prn

● .pcl

● .ps

● .cht

1. Insert the USB storage accessory into the USB
port on the front of the product.

NOTE: You might need to remove the cover
from the USB port.

NOTE: If the product does not recognize the
USB accessory, try using another type of USB
accessory. Because of differences in USB
specifications, the product does not recognize
all types of USB accessories.

 

2. At the product control panel, press the Home
 button.

 

3. Open the Retrieve Job From USB menu.  

4. Select the name of the document that you want
to print.

 

5. If you need to adjust the number of copies,
select the Copies option, and then enter the
number of copies.

 

6. Press the OK button to print the document.  
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9 Color

● Adjust color/color settings

● Use HP EasyColor

● Match colors to your computer screen
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Adjust color/color settings
Manage color by changing the settings on the Color tab in the printer driver.

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Click the HP EasyColor check box to clear it.

5. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for correct
rendering.

● Vivid (sRGB): The product increases the color saturation in the midtones. Use this theme
when printing business graphics.

● Photo (sRGB): The product interprets RGB color as if it were printed as a photograph using
a digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None: No color theme is used.
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Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Click the HP EasyColor check box to clear it.

5. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other
settings.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

6. Click the Print in Grayscale option to print a color document in black and shades of gray. Use
this option to print color documents for photocopying or faxing. You can also use this option to
print draft copies or to save color toner.

7. Click the OK button.

Manual color options

Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for
text, graphics, and photographs.
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Table 9-1  Manual color options

Setting description Setting options

Edge Control

The Edge Control setting determines the rendering
of edges. Edge control has two components:
adaptive halftoning and trapping. Adaptive
halftoning increases edge sharpness. Trapping
reduces the effect of color-plane misregistration by
overlapping the edges of adjacent objects slightly.

● Off turns off both trapping and adaptive halftoning.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is
on.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.

Halftone

Halftone options affect color output clarity and
resolution.

● Smooth provides better results for large, solid-filled print areas
and enhances photographs by smoothing color gradations. Select
this option when uniform and smooth area fills are important.

● Detail is useful for text and graphics that require sharp
distinctions among lines or colors, or images that contain a
pattern or a high level of detail. Select this option when sharp
edges and small details are important.

Neutral Grays

The Neutral Grays setting determines the method
for creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast. This setting is best for documents and grayscale viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.
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Use HP EasyColor
If you are using the HP PCL 6 printer driver for Windows, the HP EasyColor technology automatically
improves mixed-content documents that are printed from Microsoft Office programs. This technology
scans documents and automatically adjusts photographic images in .JPEG or .PNG format.
HP EasyColor technology enhances the entire image at one time, rather than dividing it into several
pieces, which results in improved color consistency, sharper details, and faster printing.

If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all
documents and automatically adjusts all photographic images with the same improved photographic
results.

In the following example, the images on the left were created without using the HP EasyColor option.
The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in both the HP PCL 6 printer driver and the HP Mac
Postscript printer driver, so you do not need to make manual color adjustments. To disable the option so
you can manually adjust the color settings, open the Color tab in the Windows driver or the Color/
Quality Options tab in the Mac driver, and then click the HP EasyColor check box to clear it.
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Match colors to your computer screen
The process of matching product output color to your computer screen is quite complex, because
printers and computer monitors use different methods of producing color. Monitors display colors by
light pixels using an RGB (red, green, blue) color process, but printers print colors using a CMYK (cyan,
magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor. These factors
include:

● Paper

● Printer colorants (inks or toners for example)

● Printing process (inkjet, press, or laser technology for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating system

● Monitors and monitor settings

● Video cards and drivers

● Operating environment (humidity for example)

Keep the above factors in mind when colors on your screen do not perfectly match your printed colors.

For most users, the best method for matching colors on your screen to your product is to print sRGB
colors.

Sample book color matching

The process for matching product output to preprinted sample books and standard color references is
complex. In general, you can obtain a reasonably good match to a sample book if the inks used to
create the sample book are cyan, magenta, yellow, and black. These are usually referred to as process
color sample books.

Some sample books are created from spot colors. Spot colors are specially created colorants. Many of
these spot colors are outside of the range of the product. Most spot color sample books have
companion process sample books that provide CMYK approximations to the spot color.

Most process sample books will state which process standards were used to print the sample book. In
most cases they will be SWOP, EURO, or DIC. To get optimal color matching to the process sample
book, select the corresponding ink emulation from the product menu. If you cannot identify the process
standard, use SWOP ink emulation.
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Print color samples

To use the color samples, select the color sample that is the closest match to the desired color. Use the
sample’s color value in your software program to describe the object you wish to match. Colors might
vary depending on paper type and the software program used. For more details on how to use the
color samples, go to www.hp.com/support/lj500colorM551.

Use the following procedure to print color samples at the product using the control panel:

1. Press the Home  button.

2. Open the following menus:

● Administration

● Reports

● Other Pages

3. Press the down arrow  to highlight either the RGB Samples or the Print CMYK Values
option, and press the OK button.

PANTONE® color matching

PANTONE has multiple color matching systems. PANTONE MATCHING SYSTEM® is very popular
and uses solid inks to generate a wide range of color hues and tints. See www.hp.com/go/
lj500colorM551_software for details on how to use PANTONE Colors with this product.

NOTE: PANTONE Colors generated might not match PANTONE-identified standards. Consult current
PANTONE Publications for accurate color.
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10 Manage and maintain

● Print information pages

● Use the HP Embedded Web Server

● Use HP Web Jetadmin

● Product security features

● Economy settings

● Clean the product

● Product updates
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Print information pages
Information pages provide details about the product and its current configuration. Use the following
procedures to print commonly used information pages:

1. At the control panel, press the Home  button.

2. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages or Other Pages

3. Use the down arrow button  to highlight a report, and then press the OK button to select it.

4. Use the up arrow button  to highlight the Print item, and then press the OK button.

Table 10-1  Reports menu

First level Second level Description

Configuration/Status Pages Administration Menu Map Prints a map of the control panel-menu
layout. The active settings for each menu are
listed.

 Configuration Page Shows the product settings and installed
accessories.

 Supplies Status Page Shows the approximate remaining life for the
supplies; reports statistics on total number of
pages and jobs processed, serial number,
page counts, and maintenance information.

HP provides approximations of the
remaining life for the supplies as a customer
convenience. The actual remaining supply
levels might be different than the
approximations provided.

 Usage Page Shows a count of all paper sizes that have
passed through the product; lists whether
they were simplex, duplex, monochrome, or
color; and reports the page count.

 File Directory Page Shows the file name and folder name for files
that are stored in the product memory.

 Current Settings Page Shows the current settings of the product.

 Color Usage Job Log Prints the color-use statistics for the product.

Other Pages Demonstration Page Prints a demonstration page that highlights
the printing capability of the product.

 RGB Samples Prints color samples for different RGB values.
Use the samples as a guide for matching
printed colors.
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Table 10-1  Reports menu (continued)

First level Second level Description

 CMYK Samples Prints color samples for different CMYK
values. Use the samples as a guide for
matching printed colors.

 PCL Font List Prints a list of all the PCL fonts that are
installed.

 PS Font List Prints a list of all the PostScript (PS) fonts that
are installed.
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Use the HP Embedded Web Server
Use the HP Embedded Web Server to view product status, configure product network settings, and to
manage printing functions from your computer instead of from the product control panel. The following
are examples of what you can do using the HP Embedded Web Server:

● View product status information.

● Determine the remaining life for all supplies and order new ones.

● View and change tray configurations.

● View and change the product control-panel menu configuration.

● View and print internal pages.

● Receive notification of product and supplies events.

● View and change network configuration.

To use the HP Embedded Web Server, your browser must meet the following requirements:

● Windows: Microsoft Internet Explorer 5.01 or later or Netscape 6.2 or later

● Mac OS X: Safari or Firefox using Bonjour or an IP address

● Linux: Netscape Navigator only

● HP-UX 10 and HP-UX 11: Netscape Navigator 4.7

The HP Embedded Web Server works when the product is connected to an IP-based network. The HP
Embedded Web Server does not support IPX-based product connections. You do not have to have
Internet access to open and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically
available.

NOTE: For complete information about using the HP Embedded Web Server, see the HP Embedded
Web Server User Guide, which is on the HP website at www.hp.com/support/lj500colorM551.

Open the HP Embedded Web Server by using a network
connection

1. At the control panel, press the Home  button.

Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

2. Use the down arrow button  to highlight the Configuration Page item, and then press the OK
button.
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3. Use the up arrow button  to highlight the Print item, and then press the OK button.

4. Locate the IP address or host name on the HP Jetdirect page.

NOTE: Mac OS X users can also use the Bonjour (mDNS) name located on the configuration
page to access the Embedded Web Server.

5. In a supported Web browser on your computer, type the product IP address or host name in the
address/URL field.

HP Embedded Web Server features

Information tab

Table 10-2  HP Embedded Web Server Information tab

Menu Description

Device Status Shows the product status and shows the estimated life remaining of HP supplies. The
page also shows the type and size of paper set for each tray. To change the default
settings, click the Change Settings link.

Job Log Shows a summary of all jobs the product has processed.

Configuration Page Shows the information found on the configuration page.

Supplies Status Page Shows the status of the supplies for the product.

Event Log Page Shows a list of all product events and errors. Use the HP Instant Support link (in
the Other Links area on all HP Embedded Web Server pages) to connect to a set
of dynamic Web pages that help you solve problems. These pages also show
additional services available for the product.

Usage Page Shows a summary of the number of pages the product has printed, grouped by
size, type, and paper print path.

Device Information Shows the product network name, address, and model information. To customize
these entries, click the Device Information menu on the General tab.

Print Upload a print-ready file from your computer to print. The product uses the default
print settings to print the file.

Print Reports and Pages Lists the internal reports and pages for the product. Select one or more items to print
or view.

General tab

Table 10-3  HP Embedded Web Server General tab

Menu Description

Control Panel Administration
Menu

Shows the menu structure of the Administration menu on the control panel.

NOTE: You can configure settings on this screen, but the HP Embedded Web
Server provides more advanced configuration options than are available through
the Administration menu.

Alert Subscriptions Set up e-mail alerts for various product and supplies events.
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Table 10-3  HP Embedded Web Server General tab (continued)

Menu Description

AutoSend Configure the product to send automated e-mails regarding product configuration
and supplies to specific e-mail addresses.

Control Panel Snapshot Shows an image of the current screen on the control-panel display.

Edit Other Links Add or customize a link to another Web site. This link appears in the Other Links
area on all HP Embedded Web Server pages.

Ordering Information Enter information about ordering replacement print cartridges. This information
appears on the supplies status page.

Device Information Name the product and assign an asset number to it. Enter the name of the primary
contact who will receive information about the product.

Language Set the language in which to display the HP Embedded Web Server information.

Date and Time Set the date and time or synchronize with a network time server.

Sleep Schedule Set or edit a wake time, sleep time, and sleep delay for the product. You can set a
different schedule for each day of the week and for holidays.

Backup and Restore Create a backup file that contains product and user data. If necessary, you can use
this file to restore data to the product.

Restore Factory Settings Restore product settings to the factory defaults.

Solution Installer Install third-party software programs that can enhance the product functionality.

Firmware upgrade Download and install product firmware upgrade files.

Statistics Services Provides connection information about third-party job-statistics services.

Print tab

Use the Print tab to enable or disable walk-up USB printing. Jobs printed from USB will use the default
print settings. the following file types are supported for walk-up USB printing:

● .pdf

● .prn

● .pcl

● .ps

● .cht

Table 10-4  HP Embedded Web Server Print tab

Menu Description

Retrieve from USB
Setup

Enable or disable the Retrieve Job From USB menu on the control panel.

Manage Stored Jobs Use this feature to manage jobs stored on the product memory.

Restrict Color Use this item to restrict the number of color pages that can be printed from this product.
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Table 10-4  HP Embedded Web Server Print tab (continued)

Menu Description

General Print Settings Use this item to manage the print settings for this product.

Manage Trays View or change paper type and size settings for each tray, and adjust general settings for all
trays.

Troubleshooting tab

Table 10-5  HP Embedded Web Server Troubleshooting tab

Menu Description

Reports and Tests Print a variety of reports to help you solve problems with the product.

Calibrations Select an option to calibrate the product immediately.

Firmware upgrade Download and install product firmware upgrade files.

Restore Factory Settings Restore product settings to factory defaults.

Security tab

Table 10-6  HP Embedded Web Server Security tab

Menu Description

General Security Configure an administrator password so you can restrict access to certain features
on the product.

Enable or disable the Host USB port on the control panel or the USB connectivity
port on the formatter for printing directly from a computer.

Access Control Configure access to product functions for specific individuals or groups. Also select
the method by which individuals sign in to the product.

Protect Stored Data Configure and manage the internal hard drive for the product. This product includes
an encrypted hard drive for maximum security.

Configure settings for jobs that are stored on the product hard drive.

Certificate Management Install and manage security certificates for access to the product and the network.

HP Web Services tab

Use the HP Web Services tab to configure and enable HP Web Services for this product. You must
enable HP Web Services to use the HP ePrint feature.

Networking tab

Use the Networking tab to change network settings for the product when it is connected to an IP-
based network. This tab does not appear if the product is connected to other types of networks.
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Other Links list

NOTE: You can configure which items appear in the Other Links list by using the Edit Other
Links menu on the General tab. The following items are the default links.

Table 10-7  HP Embedded Web Server Other Links list

Menu Description

Product Support Connects to the support site for the product, from which you can search for help
regarding various topics.

HP Instant Support Connects you to the HP Web site to help you find solutions to product problems.
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Use HP Web Jetadmin
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of
networked HP devices, including printers, multifunction products, and digital senders. This single
solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and
imaging environment — ultimately increasing business productivity by helping you save time, control
costs, and protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product
features. Visit www.hp.com/go/webjetadmin and click the Self Help and Documentation link to
learn more about updates.
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Product security features

Security statements

The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain the
product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

IP Security

IP Security (IPsec) is a set of protocols that control IP-based network traffic to and from the product.
IPsec provides host-to-host authentication, data integrity, and encryption of network communications.

For products that are connected to the network and have an HP Jetdirect print server, you can configure
IPsec by using the Networking tab in the HP Embedded Web Server.

Secure the HP Embedded Web Server

Assign an administrator password for access to the product and the HP Embedded Web Server so that
unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a
Web browser.

2. Click the Security tab.

3. Open the General Security menu.

4. In the Username field, type the name to associate with the password.

5. Type the password in the New Password box, and then type it again in the Verify
password box.

NOTE: If you are changing an existing password, you must first type the existing password in
the Old Password field.

6. Click the Apply button. Make note of the password and store it in a safe place.

Encryption support: HP High-Performance Secure Hard Disks (for
models with an encrypted hard disk)

HP LaserJet Enterprise 500 color M551xh includes an HP High-Performance Secure Hard Disk. The
hard disk provides hardware-based encryption so you can securely store sensitive data without
impacting product performance. This hard disk uses the latest Advanced Encryption Standard (AES)
and has versatile time-saving features and robust functionality.

Use the Security menu in the HP Embedded Web Server to configure the disk.
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For more information about the encrypted hard disk, see the HP High-Performance Secure Hard Disk
Setup Guide.

1. Go to www.hp.com/support.

2. Type Secure Hard Disk into the search box and press Enter.

3. Click the HP Secure High Performance Hard Disk Drive link.

4. Click the Manuals link.

Erase Job Data

There are several methods to protect data stored on the product hard drives. One solution is to
purchase a product with an HP High-Performance Secure Hard Disk. With an HP High-Performance
Secure Hard Disk, the data on the drive is not accessible if it is erased from the product. Use the Erase
Job Data feature in the HP Embedded Web Server (EWS) to securely erase print jobs from the hard
drive. Erase Job Data should be performed prior to donating, recycling, or transferring ownership of
the product.

NOTE: This feature is available on the product only when an HP High-Performance Secure Hard Disk
has been installed.

Erase Job Data

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a
Web browser.

2. Click the Security tab.

3. Open the Protect Stored Data menu.

Erase Job Data offers the following levels of disk security:

● Non-Secure Fast Erase (no overwrite)

● Secure Fast Erase (overwrites once)

● Secure Sanitize Erase (overwrites three times)

NOTE: Secure Fast Erase overwrites data once and has little performance impact. Secure Sanitize
Erase overwrites data three times and can impact performance

Data affected

Data affected by the Erase Job Data feature includes temporary files that are created during the print
process, stored jobs, proof and hold jobs, disk-based fonts, disk-based macros (forms), address books,
and HP and third-party applications.

Stored jobs are securely overwritten only when they have been deleted through the Retrieve Job
from Device Memory menu on the product after the appropriate erase mode has been set.

ENWW Product security features 177

http://www.hp.com/support


Secure stored jobs

You can protect jobs that are stored on the product by assigning a PIN to them. Anyone who tries to
print these protected jobs must first enter the PIN at the product control panel.

Lock the control panel menus

You can lock various features on the control panel by using the HP Embedded Web Server.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a
Web browser.

2. Click the the Security tab.

3. Open the Access Control menu.

4. In the Sign In and Permission Policies area, select which types of users have permission for
each of the features.

5. Click the Apply button.

Lock the formatter cage

The formatter cage, on the back of the product, has a slot that you can use to attach a security cable.
Locking the formatter cage prevents someone from removing valuable components from the formatter.
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Economy settings

Optimize speed or energy usage 

The optimum speed or energy usage feature controls the fuser cool down behavior. The following
settings are available:

Faster First Page The fuser maintains power and the first page processes faster
for any new job that is sent to the product.

Save Energy The fuser reduces power when it is idle.

Save More Energy The fuser reduces power when it is idle. The fuser reduces
more power than the Save Energy setting.

Save Most Energy The fuser is turned-off and it gradually cools to room
temperature. The Save Most Energy setting takes the
longest time to print the first page.

Complete the following steps to optimize the product for speed or energy usage:

1. Press the Home  button.

2. Open each of the following menus:

● Administration

● General Settings

● Energy Settings

● Optimum Speed/Energy Usage

3. Select the appropriate option, and then press the OK button.

Powersave modes

Disable or enable sleep mode

1. At the product control panel, press the Home  button.

2. Open each of the following menus:

● Administration

● General Settings

● Energy Settings
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● Sleep Timer Settings

● Sleep/Auto Off Timer

3. Select one of the following options:

● Enabled

● Disabled

Set the sleep timer

Use the sleep timer feature to cause the product to enter sleep mode automatically after a predefined
period of inactivity.

1. At the product control panel, press the Home  button.

2. Open each of the following menus:

● Administration

● General Settings

● Energy Settings

● Sleep Timer Settings

● Sleep/Auto Off After

3. Select the appropriate time period, and then press the OK button.

NOTE: The default value is 45 minutes.

Set the sleep schedule

Use the sleep schedule feature to reduce power consumption when the product is inactive. You can
schedule specific times of the day at which the product enters sleep mode or wakes from sleep mode.
You can customize this schedule for each day of the week. To set up a sleep schedule, use the
HP Embedded Web Server.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a
Web browser.

2. Click the General tab.

3. Click the Date and Time link, and then set the current date and time.

4. Click the Apply button.

5. Click the Sleep Schedule link, and then click the Add button to open the sleep schedule
settings.

6. Configure the sleep schedule settings.

7. Click the Apply button.
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Clean the product
Over time, particles of toner and paper accumulate inside the product. This can cause print-quality
problems during printing. Cleaning the product eliminates or reduces these problems.

Clean the paper path and print-cartridge areas every time that you change the print cartridge or
whenever print-quality problems occur. As much as possible, keep the product free from dust and
debris.

To clean the product exterior, use a soft, water-moistened cloth.

Clean the paper path

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Device Maintenance

● Calibrate/Cleaning

3. Select the Print Cleaning Page item, and press the OK button to print the page.

4. The cleaning process can take several minutes. When it is finished, discard the printed page.

Product updates
Software and firmware updates and installation instructions for this product are available at
www.hp.com/support/lj500colorM551. Click Support & Drivers, click the operating system, and
then select the download for the product.
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11 Solve problems

● Self help

● Solve general problems checklist

● Restore factory settings

● Interpret control-panel messages

● Paper feeds incorrectly or becomes jammed

● Clear jams

● Paper does not feed automatically

● Improve print quality

● The product does not print or it prints slowly

● Solve walk-up USB printing problems

● Solve connectivity problems

● Solve product software problems with Windows

● Solve product software problems with Mac
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Self help
In addition to the information in this guide, other sources are available that provide helpful information.

Printable poster for using the product
control panel

This poster is available on the product CD. It prints on four full-color pages that you
can post near the product. It contains information on using the buttons and other
features available on the product control panel.

Quick Reference Topics Several Quick Reference Topics for this product are available at this website:
www.hp.com/support/lj500colorM551.

You can print these topics and keep them near the product. They are a handy
reference for procedures that you perform frequently.

Control panel help The control panel has built-in help that guides you through several tasks, such as
replacing print cartridges and clearing jams.
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Solve general problems checklist
Follow these steps when trying to solve a problem with the product.

1. Make sure the product Ready light is on. If no lights are on, complete these steps:

a. Check the power-cable connections.

b. Check that the power is turned on.

c. Make sure that the line voltage is correct for the product power configuration. (See the label
that is on the back of the product for voltage requirements.) If you are using a power strip
and its voltage is not within specifications, plug the product directly into the wall. If it is
already plugged into the wall, try a different outlet.

d. If none of these measures restores power, contact HP Customer Care.

2. Check the cabling.

a. Check the cable connection between the product and the computer or network port. Make
sure that the connection is secure.

b. Make sure that the cable itself is not faulty by using a different cable, if possible.

c. Check the network connection.

3. The control panel should indicate ready status. If an error message appears, resolve the error.

4. Ensure that the paper that you are using meets specifications.

5. Print a configuration page. If the product is connected to a network, an HP Jetdirect page also
prints.

a. At the product control panel, press the Home  button.

b. Open the following menus:

◦ Administration

◦ Reports

◦ Configuration/Status Pages

◦ Configuration Page

c. Press the OK button to select Configuration Page and then press the up arrow  to print.

If the pages do not print, check that at least one tray contains paper.

If the page jams in the product, follow the instructions on the control panel to clear the jam.
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6. If the configuration page prints, check the following items:

a. If the page does not print correctly, the problem is with the product hardware. Contact
HP Customer Care.

b. If the page prints correctly, then the product hardware is working. The problem is with the
computer you are using, with the printer driver, or with the program.

7. Select one of the following options:

Windows: Click Start, click Settings, and then click Printers or Printers and Faxes.
Double-click the name of the product.

-or-

Mac OS X: Open the Printer Setup Utility or the Print & Fax list, and double-click the line
for the product.

8. Verify that you have installed the printer driver for this product. Check the program to make sure
that you are using the printer driver for this product. The printer driver is on the CD that came with
the product. You can also download the printer driver from this Web site: www.hp.com/support/
lj500colorM551.

9. Print a short document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work (the document
does not print), complete these steps:

a. Try printing the job from another computer that has the product software installed.

b. If you connected the product to the network, connect the product directly to a computer with
a USB cable. Redirect the product to the correct port, or reinstall the software, selecting the
new connection type that you are using.

Factors that affect product performance

Several factors affect the time it takes to print a job:

● Maximum product speed, measured in pages per minute (ppm)

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB connection

● The product I/O configuration

● The network operating system and configuration (if applicable)

● The printer driver that you are using
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Restore factory settings
1. At the product control panel, press the Home  button.

2. Open the following menus:

● Administration

● General Settings

● Restore Factory Settings

3. Select one of the available options, and then press the OK button.
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Interpret control-panel messages

Control-panel message types

Four types of control-panel messages can indicate the status of or problems with the product.

Message type Description

Status messages Status messages reflect the current state of the product. They inform you of normal product operation
and require no interaction to clear them. They change as the state of the product changes. Whenever
the product is ready, not busy, and has no pending warning messages, the Ready status message
appears if the product is online.

Warning messages Warning messages inform you of data and print errors. These messages typically alternate with the
Ready or status messages and remain until you press the OK button. Some warning messages are
clearable. If the Clearable Warnings menu in the Display Settings menu is set to the Job
option, the next print job clears these messages.

Error messages Error messages communicate that some action must be performed, such as adding paper or clearing
a jam.

Some error messages are auto-continuable. If the Continuable Events menu in the Display
Settings menu is set to the Auto continue (10 seconds) option, the product continues normal
operation after an auto-continuable error message appears for 10 seconds.

NOTE: Pressing any button during the 10-second auto-continuable error message overrides the
auto-continue feature, and the button function takes precedence. For example, pressing the Stop 
button pauses printing and offers the option to cancel the print job.

Critical-error messages Critical error messages inform you of a product failure. You can clear some of these messages by
turning the product off and then on. These messages are not affected by the Auto continue (10
seconds) setting. If a critical error persists, service is required.

Control-panel messages

The product provides robust control panel messaging. When a message appears on the control panel,
follow the on-screen instructions to resolve the issue. If the product displays an “Error” or “Attention”
message, and no steps are shown to resolve the issue, turn the product off then on. Contact HP support
if you continue to experience issues with the product.

For additional information on a variety of topics, press the Help button  on the control panel.
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Paper feeds incorrectly or becomes jammed
● The product does not pick up paper

● The product picks up multiple sheets of paper

● Prevent paper jams

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides to the appropriate indentation in the tray.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.
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5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.
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Clear jams

Jam locations

Use this illustration to identify locations of jams. In addition, instructions appear on the control panel to
direct you to the location of jammed paper and how to clear it.

NOTE: Internal areas of the product that might need to be opened to clear jams have green handles
or green labels.

1 2

3

4

5

6

1 Output-bin area

2 Duplexing area

3 Tray 1 area

4 Optional 500-sheet paper and heavy media tray (Tray 3)

5 Tray 2 pickup area

6 Fuser area
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Clear jams in the output bin area

1. If paper is visible from the output bin, grasp
the leading edge and remove it.

 

2. If jammed paper is visible in the duplex output
area, gently pull it to remove it.
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Clear jams in Tray 1

1. If jammed paper is visible in Tray 1, clear the
jam by gently pulling the paper straight out.
Touch the OK button to clear the message.

 

2. If you cannot remove the paper, or if no
jammed paper is visible in Tray 1, close Tray
1 and open the right door.

 

3. If paper is visible inside the right door, gently
pull the trailing edge to remove it.
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4. Gently pull the paper out of the pick up area.  

5. Close the right door.  
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Clear jams in Tray 2

CAUTION: Opening a tray when paper is jammed can cause the paper to tear and leave pieces of
paper in the tray, which might cause another jam. Be sure to clear jams before opening the tray.

1. Open Tray 2 and make sure that the paper is
stacked correctly. Remove any jammed or
damaged sheets of paper.

 

2. Close the tray.  
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Clear jams in the right door

CAUTION: The fuser can be hot while the product is in use. Wait for the fuser to cool before clearing
jams.

1. Open the right door.  

2. If paper is jammed as it enters the output bin,
gently pull the paper downward to remove it.

 

3. If paper is jammed inside the right door, gently
pull the paper to remove it.
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4. Lift the paper-feed cover on the inside of the
right door. If jammed paper is present, gently
pull the paper straight out to remove it.

 

1

2

5. Close the paper-feed cover.  

6. Gently pull the paper out of the pickup area.  

7. Look for paper in the Tray 2 roller area. Push
up on the two green levers to release the jam-
access door. Remove any jammed paper, and
close the door.
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8. If paper is visible entering the bottom of the
fuser, gently pull downward to remove it.

CAUTION: Do not touch the rollers on the
transfer roller. Contaminates can affect print
quality.

 

9. Paper could be jammed inside the fuser where
it would not be visible. Grasp the fuser
handles, lift up slightly, and pull straight out to
remove the fuser.

CAUTION: The fuser can be hot while the
product is in use. Wait for the fuser to cool
before clearing jams.

 

10. Open the jam-access door (callout 1). If paper
is jammed inside the fuser, gently pull it
straight up to remove it (callout 2). If the paper
tears, remove all paper fragments.

CAUTION: Even if the body of the fuser has
cooled, the rollers that are inside could still be
hot. Do not touch the fuser rollers until they
have cooled.

 

1

2
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11. Close the jam-access door, and push the fuser
completely into the product.

 

12. Close the right door.  
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Clear jams in the optional 500-sheet paper and heavy media tray
(Tray 3)

1. Open Tray 3 and make sure that the paper is
stacked correctly. Remove any damaged or
jammed sheets of paper.

 

2. Close Tray 3.  
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Clear jams in the lower right door (Tray 3)

1. Open the lower right door.  

2. If paper is visible, gently pull the jammed
paper up or down to remove it.

 

3. Close the lower right door.  
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Change jam recovery

This product provides jam recovery, a feature that you can use to reprint jammed pages. The following
options are available:

● Auto — The product attempts to reprint jammed pages when sufficient memory is available.

● Off — The product does not attempt to reprint jammed pages. Because no memory is used to
store the most recent pages, performance is optimal.

NOTE: When using this option, if the product runs out of paper and the job is being printed on
both sides, some pages can be lost.

● On — The product always reprints jammed pages. Additional memory is allocated to store the
last few pages printed. This might cause overall performance to suffer.

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Administration

● General Settings

● Jam Recovery

3. Select the appropriate setting, and then press the OK button.
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Paper does not feed automatically

Paper does not feed automatically

Cause Solution

Manual feed is selected in the software program. Load Tray 1 with paper, or, if the paper is loaded, press the
OK button.

The correct size paper is not loaded. Load the correct size paper.

The input tray is empty. Load paper into the input tray.

Paper from a previous jam has not been completely removed. Open the product and remove any paper in the paper path.

The paper size is not configured correctly for the input tray. Print a configuration page or use the control panel to
determine the paper size for which the tray is configured.

The guides in the tray are not against the paper. Verify that the paper guides are touching the paper.

The manual-feed prompt is set to Always. The product
always prompts for manual feed, even if the tray is loaded.

Load Tray 1 with paper, or, if the paper is loaded, press the
OK button.

Or, change the manual-feed prompt setting to Unless
loaded, so that the product prompts for manual feed only
when the tray is empty.

The Use Requested Tray setting on the Manage Trays
menu is set to Exclusively, and the requested tray is empty.
The product will not use another tray.

Load the requested tray.

Or, change the setting from Exclusively to First on the
Manage Trays menu. The product can use other trays if no
media is loaded in the specified tray.
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Improve print quality
You can prevent most print-quality problems by following these guidelines.

● Use the correct paper type setting in the printer driver

● Adjust color settings in the printer driver

● Use paper that meets HP specifications

● Print a cleaning page

● Calibrate the product to align colors

● Check the print cartridges

● Use the printer driver that best meets your printing needs

Use the correct paper type setting in the printer driver

Check the paper type setting if you are having any of the following problems:

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Toner flakes off the printed pages.

● Printed pages have small unprinted areas.

Change the paper type setting for Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand each category of paper types until you find the paper type that you are using.

7. Select the option for the type of paper you are using, and click the OK button.

Change the paper type setting for Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.
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4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Adjust color settings in the printer driver

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for correct
rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a digital
mini lab. The product renders deeper, more saturated colors differently than with the Default
(sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None
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Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other
settings.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and white. Use this
option to print color documents for photocopying or faxing.

6. Click the OK button.

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.
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Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use
in Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of the
following problems:

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Device Maintenance

● Calibrate/Cleaning

3. Select the Print Cleaning Page item, and press the OK button to print the page.

4. The cleaning process can take several minutes. When it is finished, discard the printed page.

Calibrate the product to align colors

Calibration is a product function that optimizes print quality. If you experience any image-quality
problems, calibrate the product.

1. Press the Home  button.

2. Open each of the following menus:

● Device Maintenance

● Calibrate/Cleaning

● Full Calibration
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Check the print cartridges

Check each print cartridge, and replace it if necessary, if you are having any of the following
problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

If you determine that you need to replace a print cartridge, print the supplies status page to find the
part number for the correct genuine HP print cartridge.

Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett-Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured
print cartridge and are not satisfied with the print quality, replace the cartridge with
a genuine HP cartridge.

Genuine HP print cartridge 1. The product control panel or the supplies status page indicates Very Low
status when the cartridge has reached the end of its designated life. Replace
the print cartridge if print quality is no longer acceptable.

2. Visually inspect the print cartridge for damage. See the instructions that follow.
Replace the print cartridge if necessary.

3. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the
repeating defects information in this document to identify the cause of the
problem.

Use the printer driver that best meets your printing needs

You might need to use a different printer driver if the printed page has unexpected lines in graphics,
missing text, missing graphics, incorrect formatting, or substituted fonts.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless you
select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5
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HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

Download additional printer drivers from this Web site: www.hp.com/go/lj500colorM551_software.
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The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

◦ If the control panel does not indicate the product is ready, turn the product off and then on
again.

◦ If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the
job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

◦ Check the light next to the network connection on the product. If the network is active, the
light is green.

◦ Make sure that you are using a network cable and not a phone cord to connect to the
network.

◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can
cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties,
and open the Ports tab.

◦ If you are using a network cable to connect to the network, make sure the printer name listed
on the Ports tab matches the product name on the product configuration page.

◦ If you are using a USB cable and are connecting to a wireless network, make sure the box is
checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/support/lj500colorM551.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.
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Solve walk-up USB printing problems
● The Retrieve From USB Settings menu does not open when you insert the USB accessory

● The file does not print from the USB storage accessory

● The file that you want to print is not listed in the Open From USB menu

The Retrieve From USB Settings menu does not open when you
insert the USB accessory

1. You must enable this feature by using the control-panel menus or the HP Embedded Web Server
before it can be used.

To enable this feature by using the control-panel menus, access the Administration menu,
General Settings sub menu, Retrieve From USB Settings sub menu, and then select
Enable. To enable this feature by using the HP Embedded Web Server, access the Print tab.

2. You might be using a USB storage accessory or a file system that this product does not support.
Save the files on a standard USB storage accessory that uses File Allocation Table (FAT) file
systems. The product supports FAT12, FAT16, and FAT32 USB storage accessories.

3. If another menu is already open, close that menu and then reinsert the USB storage accessory.

4. The USB storage accessory might have multiple partitions. (Some USB storage accessory
manufacturers install software on the accessory that creates partitions, similar to a CD.) Reformat
the USB storage accessory to remove the partitions, or use a different USB storage accessory.

5. The USB storage accessory might require more power than the product can provide.

a. Remove the USB storage accessory.

b. Turn the product off and then on.

c. Use a USB storage accessory that has its own power supply or that requires less power.

6. The USB storage accessory might not be functioning correctly.

a. Remove the USB storage accessory.

b. Turn the product off and then on.

c. Try printing from another USB storage accessory.

The file does not print from the USB storage accessory

1. Make sure that paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.
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The file that you want to print is not listed in the Open From USB
menu

1. You might be trying to print a file type that the USB printing feature does not support. The product
supports .pdf, .prn, .pcl, .ps, and .cht file types.

2. You might have too many files in a single folder on the USB storage accessory. Reduce the
number of files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case,
the product replaces the file names with characters from a different character set. Rename the files
using ASCII characters.
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Solve connectivity problems 

Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 2 m (6.56 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.

Solve network problems

Check the following items to verify that the product is communicating with the network. Before
beginning, print a configuration page from the product control panel and locate the product IP address
that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the
product is selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.
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3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change
these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer
driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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Solve product software problems with Windows

A printer driver for the product is not visible in the Printer folder

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Try plugging the USB cable into a different USB port on the computer.

An error message was displayed during the software installation

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Check the amount of free space on the drive where you are installing the product software. If
necessary, free up as much space as you can, and reinstall the product software.

3. If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode, but nothing prints

1. Print a configuration page, and verify the product functionality.

2. Verify that all of the cables are correctly seated and within specifications. This includes the USB
and power cables. Try a new cable.

3. Verify that the IP address on the configuration page matches the IP address for the software port.
Use one of the following procedures:

Windows XP, Windows Server 2003, Windows Server 2008, and Windows Vista

a. Click Start.

b. Click Settings.

c. Click Printers and Faxes (using the default Start menu view) or click Printers (using the
Classic Start menu view).

d. Right-click the product driver icon, and then select Properties.

e. Click the Ports tab, and then click Configure Port.

f. Verify the IP address, and then click OK or Cancel.

g. If the IP addresses are not the same, delete the driver, and reinstall the driver using the
correct IP address.
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Windows 7

a. Click Start.

b. Click Devices and Printers.

c. Right-click the product driver icon, and then select Printer properties.

d. Click the Ports tab, and then click Configure Port.

e. Verify the IP address, and then click OK or Cancel.

f. If the IP addresses are not the same, delete the driver, and then reinstall the driver using the
correct IP address.
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Solve product software problems with Mac
● The product name does not appear in the product list in the Print & Fax list

● The printer driver does not automatically set up the selected product in the Print & Fax list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax list after the
driver is selected.

● You are using a generic printer driver when using a USB connection

The product name does not appear in the product list in the Print &
Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax list.

3. Make sure the product and computer are on the same network or connected with a USB cable.

4. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected
product in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/
Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Replace the USB or network cable with a high-quality cable.

A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax list.
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When connected with a USB cable, the product does not appear in
the Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X v10.5 or v10.6.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate High-Speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect
all of the devices from the chain, and connect the cable directly to the USB port on the computer

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB
connection

If you connected the USB cable before you installed the software, you might be using a generic printer
driver instead of the driver for this product.

1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.
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A Supplies and accessories

● Order parts, accessories, and supplies

● Part numbers
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Order parts, accessories, and supplies

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using HP software Use the HP Embedded Web Server on page 170
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Part numbers
Ordering information and availability might change during the life of the product.

Accessories

Item Description Part number

HP Color LaserJet  1 x 500 Paper
Feeder

500-sheet paper and heavy media tray. CF084A

Print cartridges and toner collection unit

Item Description1 Cartridge number Part number

HP Color LaserJet black print
cartridge

Standard black cartridge 507A CE400A

HP Color LaserJet black print
cartridge

High-capacity black cartridge 507X CE400X

HP Color LaserJet cyan print
cartridge

Cyan cartridge 507A CE401A

HP Color LaserJet yellow print
cartridge

Yellow cartridge 507A CE402A

HP Color LaserJet magenta
print cartridge

Magenta cartridge 507A CE403A

Toner Collection Unit Receptacle for toner that has
not fused to the paper.

 CE254A

1 For more information, go to www.hp.com/go/learnaboutsupplies

Cables and interfaces

Item Description Part number

HP Jetdirect print servers HP Jetdirect ew2500 Wireless Print
Server

J8021A

 HP Jetdirect 2700w USB Wireless Print
Server

J8026A

USB cable 2-meter standard USB-compatible device
connector

C6518A
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Maintenance kits

Item Description Part number

Fuser kit 110 Volt replacement fuser CE484A

220 Volt replacement fuser CE506A
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● Hewlett-Packard limited warranty statement

● HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement

● Color LaserJet Fuser Kit, Toner Collection Unit, and Transfer Kit Limited Warranty Statement

● Data stored on the print cartridge

● End User License Agreement

● OpenSSL

● Customer self-repair warranty service

● Customer support
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Hewlett-Packard limited warranty statement

HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet Enterprise 500 color M551n, M551dn, M551xh One-year on-site warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects
in materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either repair or replace
products which prove to be defective. Replacement products may be either new or equivalent in
performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when
properly installed and used. If HP receives notice of such defects during the warranty period, HP will
replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is
unable, within a reasonable time, to repair or replace any product to a condition as warranted, you
will be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or
calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized
modification or misuse, (d) operation outside of the published environmental specifications for the
product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some
countries/regions, states or provinces do not allow limitations on the duration of an implied warranty,
so the above limitation or exclusion might not apply to you. This warranty gives you specific legal rights
and you might also have other rights that vary from country/region to country/region, state to state, or
province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for
this product and where HP has marketed this product. The level of warranty service you receive may
vary according to local standards. HP will not alter form, fit or function of the product to make it
operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE
YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR
ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL,
CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED
IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or provinces do not allow the
exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may
not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

226 Appendix B   Service and support ENWW



HP's Premium Protection Warranty: LaserJet print
cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit
wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE
FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Color LaserJet Fuser Kit, Toner Collection Unit, and
Transfer Kit Limited Warranty Statement

This HP product is warranted to be free from defects in materials and workmanship until the printer
provides a low-life indicator on the control panel.

This warranty does not apply to products that (a) have been refurbished, remanufactured or tampered
with in any way, (b) experience problems resulting from misuse, improper storage, or operation outside
of the published environmental specifications for the printer product or (c) exhibit wear from ordinary
use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem) or contact HP customer support. At HP’s option, HP will either replace products that prove
to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE
FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Data stored on the print cartridge
The HP print cartridges used with this product contain a memory chip that assists in the operation of the
product.

In addition, this memory chip collects a limited set of information exclusively for the purpose of
understanding usage of the product, which might include the following: the date when the print
cartridge was first installed, the date when the print cartridge was last used, the page coverage, the
printing modes used, and the product model. This information helps HP design future products to meet
our customers' printing needs.

The data collected from the print cartridge memory chip does not contain information that can be used
to identify a customer or user of the print cartridge or their product.

HP collects a sampling of the memory chips from print cartridges returned to HP's free return and
recycling program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling
are read and studied in order to improve future HP products. HP partners who assist in recycling this
print cartridge might have access to this data, as well.

Any third party possessing the print cartridge might have access to the anonymous information on the
memory chip. If you prefer to not allow access to this information, you can render the chip inoperable.
However, after you render the memory chip inoperable, the memory chip cannot be used in an HP
product.
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End User License Agreement
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and
(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This
EULA does not apply if there is a separate license agreement between you and HP or its suppliers for
the Software, including a license agreement in online documentation. The term “Software” may include
(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic
documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO ALL
TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR
OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO NOT
ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE SOFTWARE. IF
YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE RETURN THE
SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A REFUND OF THE
PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE AVAILABLE WITH ANOTHER
HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software (“HP
Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is in a file such as
“license.txt” or a “readme” file. You should contact HP support if you cannot find a Third Party
License. If the Third Party Licenses include licenses that provide for the availability of source code
(such as the GNU General Public License) and the corresponding source code is not included with
the Software, then check the product support pages of HP's website (hp.com) to learn how to
obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing,
copying, storing, loading, executing, displaying, or otherwise using the HP Software. You
may not modify the HP Software or disable any licensing or control feature of the
HP Software. If this Software is provided by HP for Use with an imaging or printing product
(for example, if the Software is a printer driver, firmware, or add-on), the HP Software may
only be used with such product (“HP Product”). Additional restrictions on Use may appear in
the User Documentation. You may not separate component parts of the HP Software for Use.
You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the
HP Software, provided each copy contains all the original HP Software’s proprietary notices
and is used only for back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement
(collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP as
eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you may
no longer use such HP Software. This EULA applies to each Upgrade unless HP provides other
terms with the Upgrade. In case of a conflict between this EULA and such other terms, the other
terms will prevail.
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4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of
the HP Software to another end user. Any transfer will include all component parts, media,
User Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer
may not be an indirect transfer, such as a consignment. Prior to the transfer, the end user
receiving the transferred Software will agree to this EULA. Upon transfer of the HP Software,
your license is automatically terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for
commercial timesharing or bureau use. You may not sublicense, assign or otherwise transfer
the HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are
owned by HP or its suppliers and are protected by law, including applicable copyright, trade
secret, patent, and trademark laws. You will not remove any product identification, copyright
notice, or proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s
privacy policy. HP will not use such information in a form that personally identifies you except to
the extent necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability
of HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited
to the greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS
BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
(INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION,
PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR
INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL
PURPOSE. Some states or other jurisdictions do not allow the exclusion or limitation of incidental
or consequential damages, so the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. Software was developed entirely at private expense. All
Software is commercial computer software within the meaning of the applicable acquisition
regulations. Accordingly, pursuant to US FAR 48 CFR 12.212 and DFAR 48 CFR 227.7202, use,
duplication and disclosure of the Software by or for the U.S. Government or a U.S. Government
subcontractor is subject solely to the terms and conditions set forth in this End User License
Agreement, except for provisions which are contrary to applicable mandatory federal laws.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software,
including any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you in
this EULA.

© 2009 Hewlett-Packard Development Company, L.P.

Rev. 04/09
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OpenSSL
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).
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Customer self-repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period,
HP identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part
directly to you for replacement. There are two categories of CSR parts: 1) Parts for which customer self
repair is mandatory. If you request HP to replace these parts, you will be charged for the travel and
labor costs of this service. 2) Parts for which customer self repair is optional. These parts are also
designed for Customer Self Repair. If, however, you require that HP replace them for you, this may be
done at no additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether a
defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Customer support

Get telephone support for your country/region

Have the product name, serial number, date of purchase, and
problem description ready.

Country/region phone numbers are on the flyer that was in
the box with your product or at www.hp.com/support/.

Get 24-hour Internet support www.hp.com/support/lj500colorM551

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic
information

www.hp.com/go/lj500colorM551_software

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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C Product specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Environmental specifications
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Physical specifications
Table C-1  Product dimensions

Product Height Depth Width Weight

HP LaserJet Enterprise 500 color
M551n

389 mm (15.3 in) 489 mm (19.3 in) 514 mm (20.2 in) 36.5 kg (80.5 lb)

HP LaserJet Enterprise 500 color
M551dn

408 mm (16.1 in) 489 mm (19.3 in) 514 mm (20.2 in) 37 kg (81.6 lb)

HP LaserJet Enterprise 500 color
M551xh

575 mm (22.6 in) 489 mm (19.3 in) 514 mm (20.2 in) 44.6 kg (98.3 lb)

Table C-2  Product dimensions, with all doors and trays fully opened

Product Height Depth Width

HP LaserJet Enterprise 500 color M551n 389 mm (15.3 in) 804 mm (31.7 in) 824 mm (32.4 in)

HP LaserJet Enterprise 500 color M551dn 408 mm (16.1 in) 804 mm (31.7 in) 824 mm (32.4 in)

HP LaserJet Enterprise 500 color M551xh 575 mm (22.6 in) 804 mm (31.7 in) 824 mm (32.4 in)

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/go/lj500colorM551_regulatory for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.

Environmental specifications

Environmental condition Recommended Allowed

Temperature (product and print
cartridge)

17° to 25°C (63° to 77°F) 15° to 27°C (59° to 81°F)

Relative humidity 30% to 70% relative humidity (RH) 10% to 70% RH

Altitude N/A 0 m (0 ft) to 3000 m (9842 ft)
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D Regulatory information

● FCC regulations

● Environmental product stewardship program

● Declaration of conformity

● Safety statements
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FCC regulations
This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy. If this equipment is not installed and used in accordance with the
instructions, it may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.

238 Appendix D   Regulatory information ENWW



Environmental product stewardship program

Protecting the environment
Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our
environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready or Sleep or Auto-off mode, which saves natural
resources and saves money without affecting the high performance of this product. Hewlett-Packard
printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S.
Environmental Protection Agency's ENERGY STAR specifications for imaging equipment. The following
mark will appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Paper use
This product’s manual/automatic duplex feature (two-sided printing) and N-up printing (multiple pages
printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with
HP Planet Partners. Multilingual program information and instructions are included in every new
HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
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properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.

Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For US and Puerto Rico HP LaserJet print cartridge recycling returns, use the pre-paid, pre-addressed
shipping label contained in the box. To use the UPS label, give the package to the UPS driver during
your next delivery or pick-up, or take it to an authorized UPS drop-off center. (Requested UPS Ground
pickup will be charged normal pick-up rates) For the location of your local UPS drop-off center, call
1-800-PICKUPS or visit www.ups.com.

If you are returning the package with the FedEx label, give the package to either the U.S. Postal Service
carrier or FedEx driver during your next pick-up or delivery. (Requested FedEx Ground pickup will be
charged normal pick-up rates). Or, you can drop off your packaged print cartridge(s) at any U.S. Post
Office or any FedEx shipping center or store. For the location of your nearest U.S. Post Office, please
call 1-800-ASK-USPS or visit www.usps.com. For the location of your nearest FedEx shipping center/
store, please call 1-800-GOFEDEX or visit www.fedex.com.

For more information, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle
or call 1-800-340-2445. Information subject to change without notice.
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Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal
Service provides no-cost cartridge return transportation services under an arrangement with HP for
Alaska and Hawaii.

Non-U.S. returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit
www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions
This HP product does not contain added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries
contained in or supplied by Hewlett-Packard for this product include the following:

HP LaserJet Enterprise 500 color M551

Type Carbon monofluoride lithium

Weight 1.5 g

Location On formatter board

User-removable No

For recycling information, you can go to www.hp.com/recycle, or contact your local authorities or the
Electronics Industries Alliance: www.eiae.org.
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Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop
where you purchased the product.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006
of the European Parliament and the Council). A chemical information report for this product can be
found at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.

For more information
To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of conformity

Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-0802-03-rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Enterprise 500 color M551n

HP LaserJet Enterprise 500 color M551dn

HP LaserJet Enterprise 500 color M551xh

Regulatory Model Number2) BOISB-0802-03

Including:

CF084A -- 500 Sheet Input Tray

Product Options: ALL

Print Cartridges: CE400A, CE400X, CE401A, CE402A, CE403A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006+A11

IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)

IEC 62311:2007 / EN62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1 / EN55022:2006 +A1 - Class B1), 3)

EN 61000-3-2:2006

EN 61000-3-3:2008

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class B1), 3) / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

Energy Use: Regulation (EC) No. 1275/2008 (Applies only for Class B products)

ENERGY STAR® Qualified Imaging Equipment Typical Electricity Consumption (TEC) Test Procedure

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC, the Low Voltage Directive 2006/95/EC and the

EuP Directive 2005/32/EC carries the CE-Marking  accordingly.
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This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

Boise, Idaho USA

September 2011

For Regulatory Topics only, contact:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Straße 140, D-71034, Böblingen (FAX: +49-7031-14-3143)
www.hp.eu/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Safety statements

Laser safety
The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser
product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance
Standard according to the Radiation Control for Health and Safety Act of 1968. Since radiation
emitted inside the device is completely confined within protective housings and external covers, the
laser beam cannot escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those
specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class B requirements.

« Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord instructions
Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 100-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)
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EMC statement (Korea)

Laser statement for Finland
Luokan 1 laserlaite

Klass 1 Laser Apparat

HP LaserJet Enterprise 500 color M551n, M551dn, M551xh, laserkirjoitin on käyttäjän kannalta
turvallinen luokan 1 laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen
pääsyn laitteen ulkopuolelle. Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (2007)
mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet Enterprise 500 color M551n, M551dn, M551xh - kirjoittimen sisällä ei ole käyttäjän
huollettavissa olevia kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu
henkilö. Tällaiseksi huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta
tai muita käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan
suorittaa ilman erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m W
Luokan 3B laser.

GS statement (Germany)
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert warden.
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Substances Table (China)

Restriction on Hazardous Substances statement (Turkey)
Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur

Restriction on Hazardous Substances statement (Ukraine)
Обладнання відповідає вимогам Технічного регламенту щодо обмеження використання деяких
небезпечних речовин в електричному та електронному обладнанні, затвердженого постановою
Кабінету Міністрів України від 3 грудня 2008 № 1057
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Index

Symbols/Numerics
500-sheet paper and heavy media

tray
models including 2

A
accessories

ordering 222
part numbers 223

acoustic specifications 236
Administration menu, control

panel 17
AirPrint 54
alerts, e-mail 53
anticounterfeit supplies 101
Attention light

locating 10
automatic overhead transparency

sensing 95

B
Backup/Restore menu, control

panel 34
batteries included 241
bins

locating 6
bins, output

capacity 80
Bonjour

identifying 170
booklets

creating (Windows) 149
both sides, printing on

turning on (Mac) 53
browser requirements

HP embedded Web Server
170

business graphics
printing 156

buttons, control panel
locating 10

C
cable, USB

part number 223
Calibrate/Cleaning menu, control

panel 34
Canadian DOC regulations 245
canceling

print job 55
canceling print jobs 120
cartridges

non-HP 101
recycling 101, 239
replacing 102
storage 101
warranty 227

cartridges, print
Macintosh status 59
part numbers 223

cautions iii
cleaning

paper path 181, 207
product 181

color
adjusting 160
Edge Control 162
halftone options 162
manage 159
match 164
Neutral Grays 162
Pantone® matching 165
print color samples 165
printed vs. monitor 164
printing in grayscale

(Windows) 138
sample book matching 164
using 159

color options
HP EasyColor (Windows) 163
setting (Windows) 136

color settings
adjusting 205

Color tab settings 59
configurations, models 2
configuring

IP address 65
connection

USB with Mac 48
USB with Windows 62

connectivity
solving problems 214

control panel
Administration menu 17
Backup/Restore menu 34
buttons 10
Calibrate/Cleaning menu 34
cleaning page, printing 181
Display Settings menu 25
General Settings menu 17
help 11
lights 10
locating 6
Manage Supplies menu 26
Manage Trays menu 27
messages, types of 188
Network Settings menu 28
Print Options menu 23
Print Settings menu 22
Reports menu 17
security 178
Service menu 35
settings 41, 52
Supplies menu 14
Trays menu 16
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Troubleshooting menu 32
USB Firmware Upgrade menu

35
control-panel menus

Retrieve From USB Settings 22
retrieve job from device

memory 13
Retrieve Job From USB 12
Sign In 12

controlling print jobs 95
conventions, document iii
copies

changing number of
(Windows) 122

counterfeit supplies 101
cover pages

printing (Mac) 56
printing on different paper

(Windows) 144
covers, locating 6
custom print settings (Windows)

122
custom-size paper settings

Macintosh 55
customer support

online 234

D
Data light

locating 10
default gateway, setting 68
defects, repeating 109
deleting

stored jobs 153
device status

Macintosh Services tab 59
Display Settings menu, control

panel 25
disposal, end-of-life 241
document conventions iii
double-sided printing

paper loading orientation 90
double-sided printing (duplexing)

Mac 57
turning on (Mac) 53

drivers
changing paper types and

sizes 74
changing settings (Mac) 52

changing settings (Windows)
41

paper types 78
presets (Mac) 56
settings 41
settings (Mac) 56
settings (Windows) 121
supported (Windows) 38
universal 40

duplex alignment
setting 157

duplex printing
paper loading orientation 90

duplex printing (double-sided)
settings (Windows) 129
turning on (Mac) 53

duplex settings, changing 70
duplexer

locating 6

E
e-mail alerts 53
economy settings 179
Edge Control 162
electrical specifications 236
Embedded Web Server (EWS)

assigning passwords 176
features 170
network connection 170

end-of-life disposal 241
envelopes

loading in Tray 1 82
loading orientation 90

environment, specifications 236
environmental features 4
Environmental Product Stewardship

Program 239
erase job data

security 177
error messages

control panel 188
e-mail alerts 53
types of 188

errors
software 216

European Union, waste disposal
242

Explorer, versions supported
HP Embedded Web Server

170

F
features 2
file upload, Mac 53
Finnish laser safety statement 246
firmware

update, Mac 53
first page

printing on different paper
(Windows) 144

use different paper 56
fonts

upload, Mac 53
formatter

security 178
forms

printing (Windows) 139
fraud Web site 101
fuser

jams 196

G
gateway, setting default 68
general configuration

HP Embedded Web Server
171

General Settings menu, control
panel 17

glossy paper, supported 156
graphical and text display, control

panel 10
graphics, business

printing 156
grayscale

printing (Windows) 138

H
hard disks

encrypted 176
help

printing options (Windows)
122

help, control panel 11
HP Customer Care 234
HP Easy Color

disabling 163
using 163

HP Embedded Web Server
general configuration 171
HP Web Services 173
information pages 171
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network settings 173
other links list 174
print tab 172
security settings 173
troubleshooting tools 173

HP Embedded Web Server (EWS)
features 170
network connection 170

HP ePrint
description 44, 54

HP ePrint, using 137
HP fraud Web site 101
HP Jetdirect print server

models including 2
HP Printer Utility 53
HP tough paper 157
HP Universal Print Driver 40
HP Utility 53
HP Utility, Mac 53
HP Web Jetadmin 44, 175
HP Web Services

enabling 173
HP Web Services, enabling 137
HP-UX software 45
humidity requirements 236

I
information pages

HP Embedded Web Server
171

printing or viewing 168
installing

product on wired networks,
Mac 49

product on wired networks,
Windows 65

software, USB connections 62
software, wired networks 66

interface ports
locating 7

Internet Explorer, versions
supported

HP Embedded Web Server
170

IP address
configuring 65

IP Security 176
IPsec 176
IPv4 address 68
IPv6 address 69

J
jams

causes of 189
fuser 196
lower right door 201
output bin 192
recovery 202
right door 196
Tray 1 193
Tray 2 195
Tray 3 200, 201

Japanese VCCI statement 245
Jetadmin, HP Web 44, 175
Jetdirect print server

models including 2
part number 223

job retention
setting options (Windows) 153

job storage
Macintosh settings 58
modes available 150
setting options (Windows) 153

jobs
Macintosh settings 53

jobs, print
storing permanent copies

(Windows) 154
storing permanent private

copies (Windows) 154
storing temporarily

(Windows) 154
storing temporary copies

(Windows) 154
jobs, stored

creating (Windows) 151
deleting 153
printing 152
receiving notification when

printed (Windows) 155
setting user names (Windows)

155
specifying names (Windows)

155

K
keys, control panel

locating 10
Korean EMC statement 246

L
labels

printing (Windows) 141
landscape orientation

selecting, Windows 134
laser safety statements 245, 246
last page

printing on different paper
(Windows) 144

letterhead
printing (Windows) 139

license, software 230
lights

control panel 10
link speed settings 70
Linux software 45
loading

Tray 1 82
Tray 2 84

loading paper 82
lower right door

jams 201

M
Mac

changing paper types and
sizes 55

driver settings 52, 56
problems, troubleshooting 218
removing software 51
software 53
supported operating systems

48
Macintosh

HP Printer Utility 53
resize documents 55
support 234

Macintosh driver settings
custom-size paper 55
Job Storage 58
Services tab 59
watermarks 56

Manage Supplies menu, control
panel 26

Manage Trays menu, control
panel 27

managing network 67
maps, printing 157
marketing materials

printing 156
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material restrictions 241
Material Safety Data Sheet

(MSDS) 242
media

custom-size, Macintosh
settings 55

first page 56
pages per sheet 57
supported sizes 75

memory
included 2, 53
supply errors 110

memory chip, print cartridge
description 229

memory DIMMs
security 178

Menu button 10
menus, control panel

Administration 17
Backup/Restore 34
Calibrate/Cleaning 34
Display Settings 25
General Settings 17
Manage Supplies 26
Manage Trays 27
Network Settings 28
Print Options 23
Print Settings 22
Reports 17
Service 35
Supplies 14
Trays 16
Troubleshooting 32
USB Firmware Upgrade 35

menus, control-panel
Retrieve From USB Settings 22
retrieve job from device

memory 13
Retrieve Job From USB 12
Sign In 12

mercury-free product 241
messages

e-mail alerts 53
types of 188

models, features 2
multiple pages per sheet

printing (Windows) 132

N
n-up printing

selecting (Windows) 132
names, job

specifying (Windows) 155
Netscape Navigator, versions

supported
HP embedded Web Server

170
network

password, changing 67
password, setting 67
settings, changing 67
settings, viewing 67

network settings
HP Embedded Web Server

173
Network Settings menu, control

panel 28
networks

configuring 63
default gateway 68
HP Web Jetadmin 175
IPv4 address 68
IPv6 address 69
print servers included 2
protocols supported 63
security 64
subnet mask 68

networks, wired
installing product, Mac 49
installing product, Windows

65
Neutral Grays 162
non-HP supplies 101
notes iii

O
on/off switch, locating 6
online help, control panel 11
online support 234
opening printer drivers

(Windows) 121
operating environment

specifications 236
operating systems supported 38,

48
optimize speed or energy usage

179

ordering
part numbers for 223
supplies and accessories 222

orientation
paper, while loading 90
selecting, Windows 134

other links list
HP Embedded Web Server

174
output bin

jams 192
locating 6

P
page sizes

scaling documents to fit
(Windows) 146

pages per sheet
selecting (Windows) 132

paper
covers, using different paper

144
custom-size, Macintosh

settings 55
first and last pages, using

different paper 144
first page 56
jams 189
load 82
loading orientation 90
loading Tray 3 87
pages per sheet 57
printing on preprinted letterhead

or forms (Windows) 139
selecting 206
supported sizes 75
supported types 78

paper pickup problems
solving 189

paper size
changing 74

paper sizes
selecting 127
selecting custom 127

paper type
changing 204

paper types
changing 74
selecting 127

paper, ordering 222
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paper, special
printing (Windows) 141

part numbers
print cartridges 223

PCL drivers
universal 40

personal jobs
storing temporarily

(Windows) 154
portrait orientation

selecting, Windows 134
ports

locating 7
PostScript Printer Description (PPD)

files
included 53

power
consumption 236

power connection
locating 7

power switch, locating 6
PPDs

included 53
preprinted paper

printing (Windows) 139
presets (Mac) 56
print cartridges

checking for damage 108
Macintosh status 59
memory chips 229
non-HP 101
part numbers 223
recycling 101, 239
replacing 102
storage 101
warranty 227

print job
canceling 55

print jobs
storing permanent copies

(Windows) 154
storing permanent private

copies (Windows) 154
storing temporarily

(Windows) 154
storing temporary copies

(Windows) 154
print media

loading in Tray 1 82

Print Options menu, control panel
23

print quality
improving 204
improving (Windows) 127

print server
part number 223

Print Settings menu, control panel
22

print tab
HP Embedded Web Server

172
print tasks 119
printer drivers

choosing 208
printer drivers (Mac)

changing settings 52
settings 56

printer drivers (Windows)
changing settings 41
settings 121
supported 38

printing
canceling jobs 120
from USB storage accessories

158
settings (Mac) 56
settings (Windows) 121
stored jobs 152

printing from Tray 2 84
printing on both sides

settings (Windows) 129
priority, settings 41, 52
private jobs

storing permanently
(Windows) 154

problem-solving
e-mail alerts 53
messages, types of 188
no response 210
slow response 211

product info 1
product specifications 235
proof and hold

selecting (Windows) 153
protect stored data

security 177
protocols, network 63
PS Emulation drivers 38

Q
quick copy jobs

storing (Windows) 154

R
Ready light

locating 10
recycling

HP printing supplies returns and
environmental program 240

recycling supplies 101
regulatory statements

environmental product
stewardship program 239

removing Mac software 51
removing Windows software 43
repeating defects,

troubleshooting 109
replacing printing cartridges 102
Reports menu, control panel 17
reset button 10
resize documents

Macintosh 55
Windows 146

resolution
selecting (Windows) 127

restore factory settings 187
retention, job

modes available 150
setting options (Windows) 153

Retrieve From USB Settings menu
22

retrieve job from device memory
menu 13

Retrieve Job From USB menu 12
right door

jams 196
ruler, repetitive defect 109

S
safety statements 245, 246
SAPx software 45
scale documents

Macintosh 55
Windows 146

secuity settings
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security

encrypted hard disk 176
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security features 64
security lock

locating 7
self help

accessing 184
Service menu, control panel 35
Services tab

Macintosh 59
settings

driver presets (Mac) 56
drivers 41
drivers (Mac) 52
priority 41, 52
restore factory 187

shortcuts (Windows)
creating 124
using 122

Sign In menu 12
signs, printing 157
Sleep button 10
sleep delay

disabling 180
enabling 180

sleep mode
disabling 179
enabling 179

Sleep Schedule
setting 180

sleep schedule
disabling 180
enabling 180

software
embedded Web server 44
HP Printer Utility 53
HP Web Jetadmin 44
installing, USB connections 62
installing, wired networks 66
Mac 53
problems 216
settings 41, 52
software license agreement

230
supported operating systems

38, 48
uninstalling for Windows 43
uninstalling Mac 51

Solaris software 45
solving

direct-connect problems 214

network problems 214
walk-up USB printing

problems 212
special media

guidelines 72
special paper

guidelines 72
printing (Windows) 141

specifications
electrical and acoustic 236
operating environment 236

standard output bin
locating 6

Start button 10
status

HP Utility, Mac 53
Macintosh services tab 59
messages, types of 188

Status button 10
Stop button 10
stopping print jobs 120
storage, job

Macintosh settings 53, 58
modes available 150
setting options (Windows) 153

stored jobs
creating (Windows) 151
deleting 153
printing 152
receiving notification when

printed (Windows) 155
security 178
setting user names (Windows)

155
specifying names (Windows)

155
storing

print cartridges 101
storing jobs

permanent copies (Windows)
154

permanent private copies
(Windows) 154

proof and hold (Windows)
153

setting options (Windows) 153
temporary copies (Windows)

154

temporary personal jobs
(Windows) 154

with Windows 151
subnet mask 68
supplies

counterfeit 101
memory errors 110
non-HP 101
ordering 222
part numbers 223
recycling 101, 239
replacing print cartridges 102
status, viewing with HP Utility

53
Supplies menu, control panel 14
supplies status page

printing 109
supply-status, Services tab

Macintosh 59
support

online 234
supported media 75
system requirements

HP Embedded Web Server
170

T
TCP/IP

manually configuring IPv4
parameters 68

manually configuring IPv6
parameters 69

technical support
online 234

temperature requirements 236
tips iii
toner cartridges. See print

cartridges
toner collection unit

replacing 104
tough paper 157
transparencies

printing (Windows) 141
trapping 162
Tray 1

capacity 80
double-sided printing 57
jams 193

Tray 2
jams 195
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Tray 3
jams 200, 201

trays
automatic overhead

transparency sensing 95
capacity 80
configure 94
double-sided printing 57
included 2
load 82
locating 6
Macintosh settings 53
paper orientation 90
selecting (Windows) 127

Trays menu, control panel 16
troubleshooting

control panel messages 188
direct-connect problems 214
jams 189
Mac problems 218
network problems 214
paper feed problems 189
repeating defects 109
walk-up USB printing

problems 212
Windows problems 216

Troubleshooting menu, control
panel 32

troubleshooting tools
cleaning page 181
HP Embedded Web Server

173
two-sided printing

settings (Windows) 129
turning on (Mac) 53

U
uninstalling Mac software 51
uninstalling Windows software 43
universal print driver 40
UNIX software 45
USB configuration, Mac 48
USB configuration, Windows 62
USB Firmware Upgrade menu,

control panel 35
USB storage accessories

printing from 158
user names

setting for stored jobs
(Windows) 155

W
walk-up USB printing 158
warnings iii
warranty

customer self repair 233
license 230
print cartridges 227
product 226

watermarks
adding (Windows) 148

Web browser requirements
HP Embedded Web Server

170
Web printing

HP ePrint 44, 54
Web sites

customer support 234
fraud reports 101
HP Web Jetadmin,

downloading 175
Macintosh customer support

234
Material Safety Data Sheet

(MSDS) 242
universal print driver 40

Windows
driver settings 41
drivers supported 38
supported operating systems

38
universal print driver 40
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